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保証 2

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証しま
す。この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の
費用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使
用する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再
生品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知し
ていただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包して
いただき、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送さ
れる場合において、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返
送費用を負担します。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の
費用をお客様に負担していただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障ま
たは損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を
負いません。a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷
に対する修理。b）不適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製で
はないサプライ用品の使用により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品
と統合された場合において、改造または統合の影響により当該本製品のサービスの時間または難度が増加し
たときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性
に関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があり
ます。 システムの操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルに
ある安全に関するセクションをお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コー
ドのみを使用してください。

接続と切断は正しく行ってください。 プローブと検査リードは、電圧ソースに接続されている間は接続ま
たは切断しないでください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避け
るため、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品
が正しく接地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべて
の定格とマーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マ
ニュアルを参照してください。

入力は、メイン、カテゴリ II、 III、および IV 回路に対しては、定格化されていません。

プローブの基準リードは、グランドにのみ接続してください。

電源を切断してください。 電源コードにより、電源から製品を切断します。 電源コードをさえぎらないでく
ださい。このコードは常にユーザが操作可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作
させないでください。

障害の疑いがあるときは動作させないでください。 本製品に損傷の疑いがある場合、資格のあ
るサービス担当者に検査してもらってください。

回路の露出を避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに触れ
ないでください。

湿気の多いところでは動作させないでください。

爆発しやすい環境では動作させないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュ
アルの設置方法を参照してください。
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安全にご使用いただくために

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 「警告」では、怪我や死亡の原因となる状態や行為を示します。

注意： 「注意」では、本製品やその他の資産に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

「危険」マークが表示されている場合、怪我をする危険が切迫していることを示します。

「警告」マークが表示されている場合、怪我をする可能性があることを示します。

「注意」マークが表示されている場合、本製品を含む資産に損害が生じる可能性があることを示します。

本製品では、次の記号を使用します。
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環境条件について

環境条件について

このセクションでは、製品の環境に対する影響について説明します。

製品の廃棄方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクルこの機器を生産する際には、天然資源が使用されています。この製品には、環境また
は人体に有害な可能性がある物質が含まれているため、製品を廃棄する際には適切に処理する必要があ
ります。有害物質の放出を防ぎ、天然資源の使用を減らすため、機材の大部分を再利用またはリサイクル
できるように本製品を正しくリサイクルしてください。

下に示すシンボルは、この製品が WEEE Directive 2002/96/EC（廃棄電気・電子機器に関する指令）に基
づく EU の諸要件に準拠していることを示しています。リサイクル方法については、当社のホームページ
（www.tektronix.com）のサポート／サービスの項目を参照してください。

水銀に関するお知らせこの製品に使用されている LCD バックライト・ランプには、水銀が含まれ
ています。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まい
の地域の役所等にお尋ねください。

有害物質に関する規制

この製品は Monitoring and Control （監視および制御）装置に分類され、2002/95/EC RoHS Directive（電
気・電子機器含有特定危険物質使用制限指令）の範囲外です。この製品には、鉛、カドミウム、水銀、
および六価クロムが含まれています。
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このマニュアルでは、DPO7000 シリーズ、DSA70000 シリーズ、および DPO70000 シリーズの機器の設置と
操作方法について説明します。 このマニュアルでは、基本的な操作と概念について説明します。 詳細につ
いては、機器のオンライン・ヘルプを参照してください。 このマニュアルは、次の機器を対象としています。

DPO72004 型および DSA72004 型

DPO71604 型および DSA71604型

DPO71254 型および DSA71254 型

DPO70804 型および DSA70804 型

DPO70604 型および DSA70604 型

DPO70404 型および DSA70404 型

DPO7354 型

DPO7254 型

DPO7104 型

DPO7054 型

主要な機能
DPO7000 シリーズ、DSA70000 シリーズおよび DPO70000 シリーズの機器を使用して、電子設計の検証、
デバッグ、および特性の評価を行うことができます。 主要な機能は次の通りです。

すべてのチャンネルにおいて、20 GHz の帯域幅と 50 GS/s のリアルタイム・サンプリング・レー
トを実現（DPO72004 型および DSA72004 型）

すべてのチャンネルにおいて、16 GHz の帯域幅と 50 GS/s のリアルタイム・サンプリング・レー
トを実現（DPO71604 型および DSA71604 型）

すべてのチャンネルにおいて、12.5 GHz の帯域幅と 50 GS/s のリアルタイム・サンプリング・レー
トを実現（DPO71254 型および DSA71254 型）

すべてのチャンネルにおいて、8 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実現
（DPO70804 型および DSA70804型）

すべてのチャンネルにおいて、6 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実現
（DPO70604 型および DSA70604 型）

すべてのチャンネルにおいて、4 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実現
（DPO70404 型および DSA70404 型）

すべてのチャンネルにおいて、3.5 GHz 帯域幅および 10 GS/s リアルタイム･サンプリング･レート、1
チャンネルにおいて 40 GS/s リアルタイム･サンプリング･レートを実現（DPO7354 型）

すべてのチャンネルにおいて、2.5 GHz の帯域幅と 10 GS/s のリアルタイム・サンプリング・レート、1
チャンネルでは 40 GS/s のリアルタイム・サンプリング・レートを実現（DPO7254 型）

すべてのチャンネルにおいて、1 GHz の帯域幅と 5 GS/s（オプションで 10 GS/s）のリアルタイム・サ
ンプリング・レート、1 チャンネルでは 20 GS/s（オプションで 40 GS/s）のリアルタイム・サンプリング・
レートを実現（DPO7104 型）
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すべてのチャンネルにおいて、500 MHz の帯域幅と 2.5 GS/s（オプションで 5 GS/s）のリアルタイ
ム・サンプリング・レート、1 チャンネルでは 10 GS/s（オプションで 20 GS/s）のリアルタイム・サンプ
リング・レートを実現（DPO7054 型）

拡張帯域幅機能を有効にすると、帯域幅を拡張し、パスバンドをフラット化するデジタル信号プロセッサ
（DSP）フィルタが適用されます。拡張帯域幅を使用すると、最高のサンプル・レートにおいて有効チャン
ネル全体に適合した応答が可能になります。

最大 400,000,000 サンプルのレコード長（モデルとオプションに応じて異なります）

最大 1.0% の DC 垂直ゲイン確度（モデルに応じて異なります）

4 つの入力チャンネル（ハイレゾ・モードでない場合は、各チャンネルあたり 8 ビットの分解能）、補
助トリガ入出力

サンプル、エンベロープ、ピーク検出、ハイレゾ、波形データベース、アベレージ、および高速アクイ
ジションの各アクイジション・モード

広範な GPIB コマンド・セットとメッセージ・ベースのインタフェースによるフル・プログラミング機能

トリガ・タイプには、エッジ、ロジック、パルス（ロジック・クオリファイ可能）などがあり、A トリガ・イベントお
よび B トリガ・イベントの両方で選択できます。ウィンドウ・トリガ・モードでは、定義されたウィンドウ範囲
にトリガ・ソースが入ったときまたはウィンドウ範囲からトリガ・ソースが出たときにトリガされます。トリガは
ロジック・クオリファイが可能です。セットアップ/ホールド・トリガ・モードは、クロックを基準にしてセット
アップ時間とホールド時間のうちにロジック入力の状態が変化するとトリガされます。トリガ・ジッタは、1
ps RMS 未満です（代表値。モデルに応じて異なります）。通常、200 ps 未満の幅でグリッチまたはパル
スでのトリガが可能です。モデルまたはオプションによっては、低速シリアル・トリガ、シリアル・パターン・
トリガ、およびパターン・ロック・トリガが使用可能な場合があります。

強力な測定機能（ヒストグラム、自動測定、アイ・パターン測定、および測定統計）を内蔵

数学的に波形を結合し、データ解析作業をサポートする波形を作成。演算式では、任意のフィルタが使
用できます。スペクトラム解析を使用すると、周波数領域で波形を解析できます。

色階調による波形データのサンプル密度の表示をサポートする大型 12.1 インチ（307.3 mm）高解像度
XGA カラー・ディスプレイ。水平方向、垂直方向ともに 10 目盛で表示できます。

同時に最大 4 か所までのズーム領域の表示と比較が可能な MultiView Zoom。最大 4 か所のズーム領
域を固定したり、手動または自動でスクロール可能です。

カスタマイズ可能な MyScope コントロール・ウィンドウ

直感的なグラフィック・ユーザ・インタフェース（UI）および内蔵されている、画面上で使用可能なオ
ンライン・ヘルプ

内部リムーバブル・ディスク・ストレージ

さまざまなプロービング・ソリューション

マニュアル
この製品に関する使用可能な各種マニュアルの参照先は次の通りです。

参照する項目 使用するマニュアル

取付け、操作（概要） クイック・スタート・ユーザ・マニュアル。一般的な操作方法につ
いて説明します。
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参照する項目 使用するマニュアル

詳細な操作とユーザ・インタフェース
に関するヘルプ

オンライン・ヘルプ。機器の機能を使用する際の、詳細な手順
について説明します。画面上のコントロールと要素に関する情
報については、Help ボタンまたは Help メニューからオンライ
ン・ヘルプにアクセスします。 (16 ページ 「オンライン・ヘルプ
へのアクセス」 参照)。

プログラマ用のコマンド プログラマ・ガイド（製品ソフトウェア CD に収録）。GPIB コマン
ドの文法も含まれています。

解析ツールと接続ツール OpenChoice ソリューション入門マニュアル。機器に備えられて
いるさまざまな接続と解析のツールについて説明します。

このマニュアルで使用される表記規則
本マニュアルでは、次のアイコンを使用しています。

順番に行う
手順

前面パネル
の電源

電源の接
続

ネットワーク PS2 SVGA USB
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機器の設置

機器の設置

機器を開梱し、スタンダード・アクセサリとして記載されているすべての付属品が含まれていることを確認して
ください。推奨アクセサリ、プローブ、機器のオプション、およびアップグレードについては、オンライン・ヘル
プに記載されています。最新の情報については、当社のホームページ（www.tektronix.com）をご覧ください。

スタンダード・アクセサリ

アクセサリ 当社部品番号

DPO7000 シリーズ、DSA70000 シリーズ、および DPO70000 シ
リーズ・デジタル・フォスファ・オシロスコープ・クイック・スタート・
ユーザ・マニュアル

071-1733-xx

DPO7000 シリーズ、DSA70000 シリーズ、および DPO70000 シ
リーズ製品ソフトウェア CD

020-2693-xx

オペレーティング・システム修復 CD 020-2810-xx

オプション・アプリケーション・ソフトウェア CD とマニュアル・キット 020-2700-xx

オンライン・ヘルプ（製品ソフトウェアの一部） —

性能検査（製品ソフトウェア CD に収録されている PDF ファイル） —

プログラマ・オンライン・ガイド（製品ソフトウェア CD に収録さ
れているファイル）

—

NIST、Z540-1、および ISO9000 の校正証明書 —

4 本の 10X 受動プローブ（500 MHz モデル、DPO7054 型のみ） P6139A

TekConnect アダプタ 1 個、≥4 GHz モデルのみ TCA-BNC

TekConnect アダプタ 4 個、≥4 GHz モデルのみ TCA-292MM

キーボード、≥4 GHz モデルのみ 119-7083-xx

マウス（オプティカル） 119-7054-xx

前面カバー 200-4963-xx

アクセサリ・ポーチ <4 GHz モデル： 016-1966-xx

≥4 GHz モデル： 016-1441-xx

プローブ校正およびデスキュー・フィクスチャ（説明書付き） <4 GHz モデル： 067-0405-xx

≥4 GHz モデル： 067-1586-xx

Nero OEM ソフトウェア CD 063-3781-xx
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機器の設置

アクセサリ 当社部品番号

次のいずれか <4 GHz モデル ≥4 GHz モデル

北米（オプション A0） 161-0104-00 161-0213-00

ユニバーサル・ユーロ（オプション A1） 161-0104-06 161-0209-00

英国（オプション A2） 161-0104-07 161-0210-00

オーストラリア（オプション A3） 161-0104-05 161-0211-01

スイス（オプション A5） 161-0167-00 161-0212-00

日本（オプション A6) 161-A005-00 161-0213-00

注意 : 添付さ
れた電源コード
セットは本機以
外の製品には
転用しないで下
さい。

中国（オプション A10） 161-0306-00 161-0320-00

インド（オプション A11） 161-0324-00 161-0325-00

電源コード

電源コードまたは AC アダプタなし（オプション
A99）

— —

動作の要件

1. 次のスペース要件および寸法を確
認し、カートまたはベンチに機器を
設置します。

<4 GHz モデル ≥4 GHz モデル

上部： 0 mm（0 インチ） 0 mm（0 インチ）

左側および右側： 76 mm インチ（3 インチ） 76 mm（3 インチ）

底部： 脚が取り付けられていて、フ
リップ・スタンドを下げている
場合は 0 mm（0 インチ）

脚が取り付けられていて、フ
リップ・スタンドを下げている
場合は 0 mm（0 インチ）

後部： 後部の脚が取り付けられてい
る場合は 0 mm（0 インチ)

後部の脚が取り付けられてい
る場合は 0 mm（0 インチ)

2. 幅： 456 mm（17.96 インチ） 451 mm（17.75 インチ）

3. 高さ： 277 mm（10.9 インチ） 292 mm（11.48 インチ）
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機器の設置

4. 装置を操作する前に、周囲温度を
確認してください。

5 ﾟC ～ +45 ﾟC（+41 ﾟF ～
+113 ﾟF）

5 ﾟC ～ +45 ﾟC（+41 ﾟF ～
+113 ﾟF）

5. 動作湿度を確認してください。 相対湿度 8% ～ 80% 、 最高
+32 ﾟC (+90 ﾟF)

相対湿度 5 ～ 45%（+32 ﾟ
C (+90 ﾟF) から最高 +45 ﾟC
(+113 ﾟF)、結露なし）、最高
湿球温度 +29.4 ﾟC (+85 ﾟF) (
相対湿度は +45 ﾟC (+113 ﾟF)
で 32% に低下）

相対湿度 8 ～ 80%（+45 ﾟC
（+113 ﾟF）以下で最高湿球温
度 +29 ﾟC（+84 ﾟF）、結露なし）

+45 ℃（+113 ºF）で相対湿度
の上限が 30% に低下

6. 動作高度を確認してください。 ≥4 GHz モデル： 3,000 m
(9,843 フィート)（最大動作温
度は高度 1,500 m (4921.25
フィート) より上で 300 m
(984.25 フィート)につき 1 ﾟC
の割合で低下）

<4 GHz モデル： 3,000 m
（9,843 フィート）

注意： 正しく冷却するために、オシロスコープの下側と側面には障害物を置かないでください。

機器の電源をオンにする

電源の要件

電源電圧と周波数 電力消費量

<4 GHz モデル： 100 ～ 240 VRMS ±10%、47 ～ 63 Hz
または 115 VRMS ±10%、400 Hz

最大 550 ワット

≥4 GHz モデル： 100 ～ 240 VRMS ±10%、50 ～ 60 Hz
または 115 VRMS ±10%、400 Hz
CAT II

≤1100 VA
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機器の設置

<4 GHz モデル

≥4 GHz モデル
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機器の設置

機器の電源をオフにする

電源の取り外し

<4 GHz モデル

≥4 GHz モデル
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機器の設置

ネットワークへの接続

機器をネットワークに接続して、印刷、
ファイル共有、インターネット・アクセ
スなどの通信機能を利用できます。
ネットワークに対して機器を構成する
には、ネットワーク管理者に問い合わ
せ、標準の Windows ユーティリティを
使用してください。

注： ネットワーク経由のリモート操作の場合、Display > Display Remote をオンに切り替えます。 VNC また
は pcAnywhere を機器およびリモート PC 上にインストールする必要があります。 Display Remote を有効に
すると、表示の更新、コントロール・ウィンドウへのアクセス、およびメニュー項目表示が低くなります。
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機器の設置

2 台めのモニタの追加
外部モニタで Windows やインストールされたアプリケーションを使用しながら、機器を操作できます。デュ
アル・モニタ構成をセットアップするには、次の手順に従います。

1. 電源をオフにします。

2. モニタをもう 1 台接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

<4 GHz モデル
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機器の設置

1. 電源をオフにします。

2. モニタをもう 1 台接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

≥4 GHz モデル
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機器の設置

7. Windows のデスクトップ上で右クリッ
クして、Properties を選択します。

8. Settings タブを選択します。グレー
で表示されている外部モニタ（2）を
クリックし、左のモニタ（1）にドラッ
グします。

9. 新しいモニタを有効にするように
求めるメッセージが表示されたら、
Yes を選択します。

10.Apply ボタンをクリックします。

11.Yes をクリックし、機器を再起動し
ます。
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機器の概要

機器の概要

前面パネル

1. DVD/CD-RW ドライブ

2. 前面パネル・コントロール

3. USB ポート

4. グランド端子

5. 再生データ出力

6. 再生クロック出力

7. プローブ補正出力

8. プローブ校正出力

9. チャンネル入力（1 ～ 4）

10.補助トリガ入力

11.高速エッジ出力

12.DC Probe Cal（プローブ校正）出力 <4 GHz モデル

≥4 GHz モデル
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機器の概要

後部および側面パネル

1. USB ポート

2. サイドバイサイド・ディスプレイのモ
ニタを接続するビデオ・ポート

3. マイクロフォン用の Mic コネクタ

4. スピーカ用の Line Out コネクタ

5. モニタを接続するためのオシロ
スコープ専用 XGA 出力ビデオ・
ポート

6. プリンタ接続ポート

7. Line In コネクタ

8. ネットワーク接続用の RJ-45 LAN
コネクタ

9. セントロニクス・パラレル・ポート

10.COM 1 シリアル・ポート

11. マウス用の PS-2 コネクタ

12. キーボード用の PS-2 コ
ネクタ

13.将来使用するための TekLink コ
ネクタ

14. リムーバル・ハード・ディスク・ドラ
イブ

15.コントローラ接続用の GPIB ポート

16.補助出力

17.チャンネル 3 出力

18.外部リファレンス入力

<4 GHz モデル
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機器の概要

1. リムーバル・ハード・ディスク・ドラ
イブ

2. マウス用の PS-2 コネクタ

3. USB ポート

4. セントロニクス・パラレル・ポート

5. ネットワーク接続用の RJ-45 LAN
コネクタ

6. モニタ接続用のビデオ・ポート

7. TekLink コネクタ

8. コントローラ接続用の GPIB ポート

9. Line In コネクタ

10.スピーカ用の Line Out コネクタ

11.マイクロフォン用の Mic コネクタ

12.サイドバイサイド・ディスプレイのモ
ニタを接続するビデオ・ポート

13.COM 1 シリアル・ポート

14.キーボード用の PS-2 コネクタ

15.補助出力

16. リファレンス出力

17.外部リファレンス入力

≥4 GHz モデル
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機器の概要

インタフェースおよびディスプレイ
メニュー・バーのメニューを使用すると、機器のすべての機能を管理するコマンドにアクセスできます。ツー
ルバー・モードを使用すると、最も頻繁に使用する機能にアクセスできます。

1. メニュー・バー：データ I/O、印刷、
オンライン・ヘルプ、および機器の
諸機能にアクセスします

2. ボタン／メニュー： クリックすると、
ツール・バーとメニュー・バー・モー
ドが切り替わり、ツール・バーをカ
スタマイズできます

3. 汎用ノブ・リードアウト：汎用ノブを
使用して制御するパラメータの調
整と表示を行います

4. 画面：ライブ波形、リファレンス波
形、演算波形がカーソルとともに
表示されます

5. 波形ハンドル：クリックおよびドラッ
グして、波形の垂直位置を変更し
ます。ハンドルをクリックし、汎用ノ
ブを使用して位置とスケールを変
更します。

6. コントロール・ステータス：垂直軸
の選択、スケール、オフセット、お
よびパラメータのクイック・リファレ
ンスです。

7. リードアウト：この領域には、カーソ
ルと測定リードアウトが表示されま
す。測定は、メニュー・バーまたは
ツール・バーから選択できます。コ
ントロール・ウィンドウが表示され
ると、リードアウトの組み合わせの
中には、目盛領域に移動するもの
があります。
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機器の概要

警告： 垂直クリップがある場合、リード
アウトでは低電圧を示していても、プ
ローブ・チップには危険な電圧がか
かっていることがあります。垂直クリッ

プの状態が存在している場合、 記
号がリードアウトに表示されます。振動
に関する自動測定では、信号が垂直
方向にクリッピングすると測定結果が
不正確になります。また、クリッピング
があると、他のプログラムで使用する
ためにエクスポートまたは保存される
波形の振幅値が不正確になります。
演算波形がクリッピングされている場
合、その演算波形の振幅測定には影
響を与えません。

8. ステータス：アクイジション・ステー
タス、モード、およびアクイジション
数、トリガ・ステータス、日時、およ
びレコード長と水平軸パラメータの
クイック・リファレンスを表示します

1. ボタン／メニュー：クリックすると、
ツール・バーとメニュー・バー・モー
ドが切り替わり、ツール・バーをカ
スタマイズできます

2. カーソルをドラッグして、画面上の
波形を測定します

3. 位置アイコンをドラッグして、波形
を移動します

4. アイコンをクリックして、汎用ノブを
波形の垂直位置およびスケール
に割り当てます

5. 波形領域を斜めにドラッグして、
ズームしたり、ヒストグラムを有効／
無効にしたり、ゲート測定を行うた
めのボックスを作成します

6. アイコンをドラッグして、トリガ・レベ
ルを変更します
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機器の概要

コントロール・パネル

1. 選択されたチャンネルに基づい
て、自動的に垂直、水平、トリガの
コントロールをセットアップする場
合に押します。

2. 設定をデフォルト値に戻す場合に
押します。

3. ハードコピーを作成するか、また
は画面表示を保存する場合に押
します。

4. MultiView Zoom をオンにして、画
面に拡大目盛を追加する場合に
押します。

5. すべての波形の水平方向のスケー
ル、位置、遅延を調整したり、レ
コード長（分解能）を設定したりで
きます。

6. アクイジションの開始と停止、シン
グル・アクイジション・シーケンスの
開始、データのクリア、あるいは高
速アクイジションを開始する場合
に使用します。

7. トリガ・パラメータを設定する場合
に使用します。Advanced を押す
と、追加のトリガ機能が表示できま
す。Arm、Ready、および Trig’D ラ
ンプにより、アクイジション・ステー
タスを示します。

8. このノブを回して、波形輝度を調
整します。

9. このノブを回して、画面インタフェー
スで選択したパラメータを調整しま
す。標準調整と微調整を切り替え
る場合に押します。

10.カーソルのオンとオフを切り替える
場合に押します。

11. このボタンはタッチ・スクリーンの
オンとオフを切り替える場合に押
します。

12.チャンネル表示のオンとオフを切
り替えます。波形の垂直方向のス
ケール、位置、あるいはオフセット
調整を行います。位置とオフセット
が切り替わります。
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機器の概要

オンライン・ヘルプへのアクセス
オンライン・ヘルプでは、機器のすべての機能に関する詳しい情報を参照できます。

アクティブなウィンドウに関する状況
に応じたヘルプにアクセスするには、
Help > Help on Window... を選択する
か、または F1 キーを押します。

1. ヘルプ・システム内の任意のトピッ
クを参照するには、Help > Contents
and Index...を選択します。

2. Contents、Index、Search、または
Favorites タブを使用して項目を選
択し、Display をクリックします。

ヘルプ・システム内を移動するには、
以下の操作を行います。

ヘルプ・ウィンドウ内のボタンをク
リックすると、概要と個別の項目の
表示を切り換えることができます。

機器を操作できるようにヘルプを
非表示にする場合は、ヘルプ・ウィ
ンドウの Minimize ボタンをクリック
します。

直前に表示したヘルプ・トピックを
もう 1 度表示するには、Alt キーお
よび Tab キーを押します。
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機器の概要

メニューおよびコントロール・ウィンドウへのアクセス
次の手順を使用して、メニューやコントロール・ウィンドウにアクセスできます。

メニューをクリックし、コマンドを選
択します。

ショートカット・メニューを表示する
には、目盛内の任意の場所また
はオブジェクトを右クリックします。
ショートカット・メニューは状況依存
であるため、右クリックした領域ま
たはオブジェクトに応じてメニュー
が異なります。いくつかの例を右の
図に示します。

ツール・バー・モードで、ボタンを
クリックすると、セットアップ・コント
ロール・ウィンドウにすばやくアクセ
スできます。 (13 ページ参照)。
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機器の検査

機器の検査

機器の機能を確認するには、次の手順を使用します。

注： 機器のクリーニングが必要な場合は、機器のサービス・マニュアルを参照してください。

内部診断合格の確認

1. 機器の電源をオンにします。

2. Instrument Diagnostics... を選択
します。
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機器の検査

3. Run をクリックします。診断コント
ロール・ウィンドウにテスト結果が
表示されます。

4. すべてのテストに合格していること
を確認します。診断が失敗した場
合は、当社のサービス担当者にお
問い合わせください。

信号パス補正
最後に信号パス補正が実行されてから温度が 5 ℃（9 ºF）以上変化した場合は、この手順を実行しま
す。信号パス補正は、週に一度実行してください。実行しなければ、機器が保証されている性能レ
ベルを満たさない可能性があります。

1. 必要条件：機器の電源を入れ、20
分間オンのままにし、すべての入
力信号を取り外します。

2. Instrument Calibration を選択しま
す。
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機器の検査

3. ステータスが Temp に変化したら、
Calibrate をクリックして校正を開始
します。校正には 10 ～ 15 分間
かかります。

4. Pass にならない場合は、機器を再
度校正するか、資格のあるサービ
ス担当者による機器のサービスを
受けてください。
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アクイジション

アクイジション

このセクションでは、アクイジション・システムを使用する概念とその手順について説明します。

信号入力のセットアップ
信号を取り込むために機器を設定するには、前面パネルのボタンを使用します。

1. プローブを入力信号ソースに接続
します。

<4 GHz モデル

≥4 GHz モデル

2. 前面パネルのボタンを押し、入力
チャンネルを選択して、チャンネル
のオンとオフを切り替えます。
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アクイジション

3. Autoset を押します。

4. 前面パネルのノブを使用して、垂
直位置、スケール、およびオフセッ
トを調整します。（ノブを押すと、位
置とオフセットが切り替わります。）

5. 前面パネルのノブを使って、水平
位置とスケールを調整します。

水平位置によって、プリトリガとポス
トトリガのサンプル数が決まります。

デフォルト設定の使用

1. 設定を出荷時デフォルト設定にす
ばやく戻すには、Default Setup を
押します。
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アクイジション

オートセットの使用
オートセットを使用すると、入力信号の特性に基づいて、機器（アクイジション、水平軸、トリガ、および垂直
軸）をすばやく自動的にセットアップできます。オートセットでは、波形の 2 つまたは 3 つのサイクルと中間
レベル付近のトリガ・レベルを表示するように信号が調整されます。

1. プローブを接続してから、入力チャ
ンネルを選択します。(21 ページ
「信号入力のセットアップ」 参照)。

2. Autoset ボタンを押して、オートセッ
トを実行します。

3. 直前のオートセットを取り消すに
は、Undo をクリックします。オート
セットにより影響を受けないパラ
メータの設定は変更されません。

ヒント

オートセットでは、波形の位置を適切に調整するために垂直軸位置が変更される場合があります。ま
た、オートセットでは、垂直オフセットが調整される場合もあります。

1 つまたは複数のチャンネルが表示されているときに Autoset（オートセット）を実行すると、機器は最
も数の小さいチャンネルを水平スケールおよびトリガに選択します。各チャンネルの垂直スケーリン
グは個別に操作できます。

チャンネルが表示されていないときにオートセットを実行すると、機器はチャンネル 1（Ch 1）をオン
にし、スケーリングします。

X をクリックして、Autoset Undo コントロール・ウィンドウを閉じます。Autoset Undo を閉じても、Edit メ
ニューから Undo Last Autoset コマンドを選択して、直前のオートセットを取り消すことができます。

Utilities メニューの User Preferences を変更すると、自動的に Autoset Undo コントロール・ウィンドウ
を表示しないように設定できます。

プローブの補正、校正、およびデスキュー
測定確度を最適化するには、機器のオンライン・ヘルプを参照して、次の手順を実行します。

受動プローブの補正
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機器の信号パスの補正

アクティブ・プローブの校正

入力チャンネルのデスキュー

アクイジションの概念

アクイジション・ハードウェア

信号を表示するには、信号が入力チャンネルを通過し、そこでスケーリングおよびデジタル化される必要が
あります。各チャンネルには、専用の入力増幅器とデジタイザがあります。各チャンネルはデジタル・データ
のストリームを生成し、機器はそのデータから波形レコードを抽出します。

サンプリング処理

アクイジションは、アナログ信号をサン
プリングしてデジタル・データに変換
し、それを波形レコードにまとめる処理
です。作成された波形レコードは、ア
クイジション・メモリに格納されます。

リアルタイム ・ サンプリング

リアルタイム・サンプリングでは、1 つ
のトリガ・イベントを使用して取り込ん
だポイントをすべてデジタル化します。
単発現象や過渡的現象を取り込む
場合は、リアルタイム・サンプリングを
使用します。

補間リアルタイム・サンプリング

補間リアルタイム・サンプリングでは、1
つのトリガ・イベントを使用して取り込ん
だポイントをすべてデジタル化します。
機器が最大リアルタイム・サンプリン
グ・レートで完全な波形を表すのに十
分なサンプルを取得できない場合は、
サンプルが補間されます。単発現象や
過渡的現象を取り込む場合、あるいは
低速アクイジションの場合に、補間リア
ルタイム・サンプリングを使用します。
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等価時間サンプリング

機器のリアルタイム・サンプリングの最
大サンプリング・レートよりも速いレー
トでサンプリングするには、等価時間
サンプリングを使用します。等価時間
サンプリングは、Equivalent Time（等
価時間）が選択されていて、リアルタイ
ム・サンプリングを使って波形のレコー
ドを作成するのに速すぎるサンプリン
グ・レートにタイム・ベースが設定され
ている場合にのみ使用されます。

機器は、波形を複数回取り込むこと
で、完全な波形レコードの作成に必要
なサンプル密度を取得します。つま
り、等価時間サンプリングは、繰り返し
信号にだけ使用します。

波形レコード

本機器は、次のパラメータを使って、
波形レコードを生成します。

サンプル・インターバル：サンプ
ル・ポイント間の間隔。

レコード長：波形レコードの生成に
必要なサンプル数。

トリガ・ポイント：波形レコード内の
時刻ゼロの基準。

水平位置：水平遅延がオフの場
合、水平位置は、で示される波形
レコードの割合（0 ～ 99.9%）です。
トリガ・ポイントと水平基準ポイント
は、波形レコード内の同じ時間に
なります。たとえば、水平位置が 50
パーセントである場合は、トリガ・
ポイントは、波形レコードの中央に
なります。水平遅延がオンの場合
は、トリガ・ポイントから水平基準の
時間が水平遅延となります。
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補間

本機器では、取り込んだサンプルの間を補間できます。補間は、波形レコードに必要な実際のサンプ
ルが不足している場合に行われます。直線補間法は、直線を使用して、実際の取り込みサンプルの
間のレコード・ポイントを計算します。

Sin(x)/x 補間法は、 取り込まれた実際の値の間の曲線を使って、レコード・ポイントを計算します。Sin(x)/x
補間法はデフォルトの補間モードです。これは、波形を正確に表わすのに必要なサンプル・ポイント
が直線補間法より少ないためです。

ヒント

Intensified Samples 表示スタイルを使用すると、実際のサンプルを高輝度で表示したり、補間されたサン
プルを暗く表示することができます。(47 ページ 「表示スタイルの選択」 参照)。

アクイジション・モードの仕組み

Sample モードでは、各アクイジション
間隔から最初にサンプリングされたポ
イントが維持されます。このモードはデ
フォルトのモードです。

Peak Detect モードでは、連続した 2
つのアクイジション間隔に含まれるす
べてのサンプルの最大および最小の
サンプルが使用されます。このモード
は、補間のないリアルタイムのサンプリ
ングでのみ使用でき、高周波数のグ
リッチを捕捉するのに便利です。

Hi Res モードでは、各アクイジション
間隔にあるすべてのサンプルの平均
が計算されます。ハイレゾは、高分解
能で低帯域幅の波形を表示します。

Envelope モードでは、多くのアクイジ
ションから最大および最小のレコード・
ポイントが特定されます。エンベロー
プ・モードでは、各アクイジションに
ピーク・ディテクトを使用します。
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Average モードでは、多数のアクイジ
ションの各レコード・ポイントの平均値
が計算されます。平均モードでは、各
アクイジションにサンプル・モードを使
用します。平均モードを使用すると、
不規則ノイズが減少します。

Waveform Database モードは、複数の
アクイジションで取り込んだソース波形
データを 3 次元的に累積します。振幅
とタイミング情報に加え、データベース
には、特定の波形ポイント（時間と振
幅）が取り込まれた回数も含まれます。
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アクイジション・モードの変更
アクイジション・モードを変更するには、以下の手順を使用します。

1. Horiz/Acq > Acquisition Mode を
選択します。

2. アクイジション・モードを選択する
には、次のいずれかの手順を実
行します。

メニューからアクイジション・モー
ドを直接選択します。

Mode... をクリックし、アクイジ
ション・モードを選択します。

3. アベレージ・アクイジション・モード
またはエンベロープ・アクイジショ
ン・モードの場合は、# of Wfms コ
ントロールをクリックしてから、汎用
ノブを使用して波形の数を設定し
ます。波形データベース・モードで
は、Samples コントロールをクリック
してから、汎用ノブを使用してサン
プルの数を設定します。

ヒント

キーパッド・アイコンをクリックして、波形またはサンプルの数を設定します。
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アクイジションの開始および停止
取り込みチャンネルを選択したら、次の手順を実行します。

1. 前面パネルの Run/Stop ボタンを
押して、アクイジションを開始しま
す。

2. Run/Stop ボタンをもう一度押して、
アクイジションを停止します。

3. 単発のアクイジションを取得するに
は、Single を押します。

高速アクイジションの使用
高速アクイジション・モードは、波形アクイジション間のデッド・タイムを減少させ、グリッチやラント・パルスな
どの過渡的現象を取り込んで、表示できます。また、高速アクイジション・モードでは、発生頻度に応じ
た輝度で波形現象を表示できます。

次の手順を使用します。

1. FastAcq を押します。

2. グリッチ、過渡的現象、あるいは他
の不規則現象を探します。

異常が特定できたら、トリガ・システ
ムをセットアップして、その異常を観
察します。 (101 ページ 「間欠的に
発生する異常の取り込み」 参照)。
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DSP 拡張帯域幅の使用
機器に拡張帯域幅機能が備えられている場合は、より正確な立上り時間測定を実行するために、デジタル
信号処理（DSP）拡張帯域幅を使用して帯域幅を拡大し、最大のサンプル・レートにおけるパスバンドを
フラット化します。拡張帯域幅を使用すると、有効チャンネル全体に適合した応答が可能になるため、
チャンネル間の比較測定および差動測定を行うことができます。

1. Autoset を押して、水平、垂直、お
よびトリガのコントロールを設定す
るか、または手動でコントロールを
設定します。

2. Vertical > Bandwidth Enhanced...
を選択します。

3. Auto:DSP をクリックして、拡張帯域
幅をオンにします。

一部の機器には、拡張帯域幅の
追加選択肢があります。

拡張帯域幅がオンになると、垂直
リードアウトに BW+ インジケータが
表示されます。
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ヒント

DSP 拡張帯域幅は、最大のサンプル・レートで発生します。

信号の立上り時間が 50 ps 未満の場合に、DSP 拡張帯域幅が使用できます。

高い波形スループットや過負荷信号の場合、および独自の DSP 後処理を使用する場合には、DSP 拡
張帯域幅をオフにします。

ロール・モードの使用
ロール・モードでは、低周波信号をストリップ・チャート・レコーダのように表示できます。ロール・モードを使
用すると、完全な波形レコードが取り込まれるのを待たずに、取り込んだデータ・ポイントを表示できます。

1. Horiz/Acq >Horizontal/Acquisition
Setup... を選択します。

2. 選択されていない場合は、
Acquisition タブをクリックします。
Auto をクリックし、ロール・モード
をオンにします。

注： ロール・モードでは、サンプル、
ピーク検出、またはハイレゾのアクイ
ジション・モードを使用する必要があ
ります。

3. ロール・モードでのアクイジション
を停止するには

シングル・シーケンスでない場
合は、Run/Stop を押してロー
ル・モードを停止します。

シングル・シーケンスの場合は、
完全なレコードが取り込まれる
と、ロール・モード・アクイジショ
ンが自動的に停止します。

ヒント

エンベロープ、アベレージ、波形データベース・アクイジション・モードに切り換えても、ロール・モー
ドはオフになります。

水平スケールを 50 ms/div 以上に設定すると、ロール・モードは無効になります。
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FastFrame モードの使用
FastFrame を使用すると、多くのトリガ・イベントを単一のレコードとして大きなレコードに取り込み、各レ
コードを個別に表示して測定できます。タイム・スタンプを使用すると、特定のフレームの絶対トリガ時間
や特定の 2 つのフレームのトリガ間の相対時間を表示できます。

1. Autoset を押して、水平、垂直、お
よびトリガのコントロールを設定す
るか、または手動でコントロールを
設定します。

2. Horiz/Acq > FastFrame Setup... を
選択します
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3. FastFrame をクリックして On にし
ます。

4. Frame Size および # of Events
Frames を選択します。次に、汎用
ノブを使用して、それぞれを設定
します。フレーム数は、取込まれる
トリガ・イベントの数を表します。フ
レーム・サイズは、各トリガ・イベント
（またはフレーム）で保存されるサ
ンプルの数です。メモリ不足です
べてのレコードを保存できない場
合は、フレーム数が減少します。

5. Frame Viewing コントロールを使
用して、表示するフレームを選択
します。

6. 複数のフレームを重ねて表示する
場合は、Overlay を選択します。

7. Time Stamps コントロールを使用し
て、基準フレームのソースとフレー
ム番号を選択します。基準フレー
ムは、2 つのフレーム間の相対時
間を測定する際の開始ポイントと
なります。

ヒント

FastFrame は、各トリガ・イベントに関連したデータを保持して、詳細な解析や視覚的な検証を行う
場合に使用します。
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FastFrame は、イベント間に不要な長いデッド・タイムがあるような複数のイベントを取り込む場合
に使用します。

Temp または Spectral を使用する場合、選択されたフレームが濃い青色で表示されて見にくい場合
があります。Normal、Green、あるいは Gray のカラー・パレットを使用すると、複数のフレームが最
も見やすくなります。

FastFrame フレーム・ファインダの使用
フレーム・ファインダでは、他のフレームとは異なる FastFrame のフレームを見つけることができます。

1. FastFrame フレームのソースを選
択します。

2. From Frame # および To Frame #
を入力して、検索範囲を設定しま
す。

3. Run/Stop を押して、アクイジション
を停止します。

4. Start をクリックして、検索を開始
します。
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フレーム・ファインダは異なるフレーム
を探し出して表示します。

5. 検索している異常が表示フレーム
内にない場合、No をクリックしま
す。フレーム・ファインダは別の異
なるフレームを検索します。

6. 検索している異常が表示フレーム
内にある場合は、Yes をクリックし
ます。

7. 検索を終了する場合は、Stop をク
リックします。

8. Run/Stop を押して、アクイジション
を再開します。

DPO7000 シリーズおよび DPO70000 シリーズ・クイック・スタート・ユーザ・マニュアル 35



ピンポイント・トリガ

ピンポイント・トリガ

ピンポイント・トリガ・システムは、A および B トリガの両方で使用できる拡張トリガ・タイプを備えており、
特定の数のイベントや一定の時間の後で B イベントが発生しない場合に、トリガ・シーケンスをリセット
することができます。ピンポイント・トリガは、最も複雑なトリガ・イベントや連続したトリガ・イベントを基に
したイベントの取り込みをサポートしています。

このセクションでは、トリガ・システムを使用する概念と手順について説明します。詳細については、オ
ンライン・ヘルプを参照してください。

トリガの概念

トリガ・イベント

トリガ・イベントは、波形レコードに時刻ゼロ・ポイントを設定します。すべての波形レコード・データは、そ
のポイントを基準にして時間順に並べられます。機器は、波形レコードのプリトリガ部分が一杯になるま
で、サンプル・ポイントを連続的に取り込んで保持します。トリガ・イベントが発生すると、機器はサンプル
の取り込みを開始して、波形レコードのポストトリガ部分（トリガ・イベントの後、つまり右側に表示される
部分）を作成します。トリガが認識されると、アクイジションが完了し、ホールドオフ時間が切れるまで、
機器は次のトリガを受け入れません。

トリガ・モード

トリガ・モードは、トリガ・イベントがない場合に機器の動作を決定します。

ノーマル・トリガ・モードは、トリガされた場合にだけ機器が波形を取り込むことができるようにします。トリ
ガが発生しない場合は、直前に取り込まれた波形レコードが表示されたままになります。直前の波形が
存在しない場合は、波形は表示されません。

オート・トリガ・モードは、トリガが発生しない場合でも、機器が波形を取り込むことができるようにします。
オート・モードは、トリガ・イベントの発生後に開始されるタイマを使用します。タイマーのタイムアウトまで
に別のトリガ・イベントが検出されないと、機器は、強制的にトリガを実行します。トリガ・イベントを待機
する時間は、タイムベース設定に基づきます。

オート・モードでは、有効なトリガ・イベントがなくてもトリガが強制され、ディスプレイ上の波形が同期しませ
ん。波形は、画面全体に波打って表示されます。有効なトリガが発生すると、表示は安定します。

エッジ・トリガ・モードでは、Trigger Setup コントロール・ウィンドウで Force Trigger ボタンをクリックし、強制
的にトリガを実行することができます。

Trig > Mode メニューで、トリガ・モードを選択します。詳細については、機器のオンライン・ヘルプを参
照してください。

トリガ・ホールドオフ

アクイジションを開始した後、それ以降にトリガを認識させない期間を延長することで、トリガ・ホールドオフは
トリガを安定させるのに役立ちます。そのように延長することで、システムが繰り返しバーストの残りのイベント
をスキップするのに役立ち、各バーストでは必ず最初のイベントでトリガが行われるようになります。機器が好
ましくないトリガ・イベントでトリガしている場合は、ホールドオフを調整すると、安定したトリガが得られます。

Trig > Holdoff メニューで、トリガ・ホールドオフを設定します。詳細については、機器のオンライン・
ヘルプを参照してください。
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トリガ・カップリング

トリガ・カップリングでは、信号のどの部分がトリガ回路に渡されるかを指定します。エッジ・トリガでは、有効
なすべてのカップリング・タイプ（AC、DC、低周波除去、高周波除去、ノイズ除去）を使用できます。その他
のトリガ・タイプでは、DC カップリングだけを使用します。

Trig > A Event (Main) Trigger Setup メニューで、トリガ・カップリングを選択します。詳細については、
機器のオンライン・ヘルプを参照してください。

水平位置

水平位置により、波形レコード上でトリガが発生する位置を定義します。この操作により、機器がトリガ・イ
ベントの前後に取り込みを行う数を選択できます。トリガの前にあるレコードは、プリトリガ部分です。トリ
ガの後にあるレコードは、ポストトリガ部分です。

プリトリガ・データは、トラブルシューティングに役立つ場合があります。たとえば、テスト回路にある不要なグ
リッチの原因を調査する場合は、プリトリガ期間を十分に長くしてグリッチでトリガすることで、グリッチの前の
データを取り込むことができます。グリッチの前に発生する事象を解析することによって、グリッチの原因の
調査に役立つ情報を入手できる可能性があります。または、トリガ・イベントの結果としてシステムで発生し
ている内容を見る場合は、ポストトリガ期間を十分に長くして、トリガ後のデータをキャプチャします。

スロープおよびレベル

スロープ・コントロールは、信号の立上りエッジと立下りエッジのどちらでトリガ・ポイントを検出するかを決定
します。レベル・コントロールは、トリガ・ポイントがあるエッジ上の場所を決定します。

遅延トリガ・システム

A（メイン）トリガ・システムだけを使用してトリガすることも、A（メイン）トリガと B（遅延）トリガを併用して連続的
なイベントをトリガすることもできます。シーケンス・トリガを使用する場合は、A トリガ・イベントによってトリガ・
システムが動作可能になり、B トリガ条件が満たされると、B トリガ・イベントによって機器がトリガされます。A
トリガと B トリガには、個別にソースを設定できます（通常は個別）。B トリガ条件は、時間遅延や特定のイベ
ント数に基づいて設定できます。(42 ページ 「A（メイン）トリガおよび B（遅延）トリガの使用」 参照)。
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ピンポイント・トリガ

トリガ・タイプの選択

本機器では、前面パネルで基本的なトリガ・パラメータを変更したり、Trigger Setup コントロール・ウィンドウ
でより高度なトリガをセットアップしたりすることができます。

注： 機器によっては選択できないトリガ・タイプもあります。

1. Edge を押します。

2. ソース、スロープ、およびモードを
設定します。カップリングを設定す
るには、Trig > Edge Setup メニュー
を使用します。

3. 他のトリガ・タイプを選択するには、
以下の手順に従います。

Advanced を押します。

Trig メニューからトリガ・タイプ
を直接選択します。

4. トリガ・タイプに表示されるコント
ロールを使って、トリガの設定を完
了します。トリガを設定するための
コントロールは、トリガ・タイプによっ
て異なります。

38 DPO7000 シリーズおよび DPO70000 シリーズ・クイック・スタート・ユーザ・マニュアル



ピンポイント・トリガ

ピンポイント・トリガ一覧

トリガ・タイプ トリガの設定できる場合

エッジ スロープ・コントロールの定義に従い、立上がりエッジまたは立下りエッジ
にトリガさせます。カップリングとして、DC、AC、LF 除去、HF 除去、お
よびノイズ除去を選択できます。

グリッチ 指定した幅よりも狭い（または広い）パルスの場合にトリガさせるか、指定
した幅よりも狭いグリッチを無視します。

パルス幅 指定した時間範囲内または範囲外のパルスでトリガさせます。正のパル
スまたは負のパルスでトリガできます。

ラント 2 つのしきい値の一方を通過してから他方を通過する前に、最初のしき
い値を再度通過するパルス振幅でトリガします。正または負のラント、ま
たは指定した幅より広いラントを検出できます。これらのパルスは、他の
チャンネルのロジック・ステートでもクオリファイできます。

ウィンドウ 入力信号が上限しきい値レベルを超えた場合、または下限しきい値レベ
ルを下回った場合にオシロスコープをトリガさせます。信号がしきい値
ウィンドウに入ったときまたは出たときに機器をトリガさせます。Trigger
When Wider オプションを使用して時間により、または Trigger When
Logic オプションを使用して他のチャンネルのロジカル・ステートにより、ト
リガ・イベントをクオリファイします。

タイムアウト 指定した時間内に パルスが検出されない場合にトリガします。

トランジション 指定した時間より高速または低速に 2 つのしきい値の間を遷移するパ
ルス・エッジを検出してトリガさせる。パルス・エッジは正または負です。

シリアル 64 ビットのシリアル・パターンの場合は、最大 1.25 Gb/s（4 GHz 未満
のモデル）のデータ・レート、40 ビットのシリアル・パターンの場合は、
最大 3.125 Gb/s （4 GHz 以上のモデル）のデータ・レートでトリガしま
す。 オプション PTM 型または PTH 型が必要です。 このモードにはク
ロック・リカバリが搭載されています。 Push Set 50% ノブを押して、クロッ
ク・リカバリを再度初期化します。

パターン ロジック入力信号によって選択した関数が True または False になる場
合にトリガします。指定した時間だけ論理条件を満たしてからトリガす
るように指定することもできます。

ステート クロック入力の状態が変化したときに、選択した論理関数へのすべての
ロジック入力によって関数が True または False になるときにトリガします。

セットアップ
/ ホールド

クロックを基準にしてセットアップ時間とホールド時間のうちにロジック
入力の状態が変化した場合にトリガします。

コミュニケー
ション

通信コードおよび通信スタンダードに基づいたマスク・テストと連動してト
リガします。 トリガ・イベントのパラメータは、コントロールを使用して指定
できます（オプション MTM 型または MTH 型で利用可能）。 このモード
にはクロック・リカバリが搭載されています。 クロック・リカバリを再度初
期化するには、Push Set 50% ノブを押します。

ビデオ コンポジット・ビデオ信号の指定したフィールド、またはラインでトリガしま
す。コンポジット信号フォーマットのみがサポートされています。

SPI シリアル・ペリフェラル・インタフェース（SPI）信号でトリガします。
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ピンポイント・トリガ

トリガ・タイプ トリガの設定できる場合

I2C 開始、停止、繰り返し開始、ACK なし、アドレス、データ、およびアドレス
とデータなどの Inter-IC 制御（I2C）信号でトリガします。

RS-232 RS-232 信号でトリガします。

CAN CAN バス信号でトリガします。
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ピンポイント・トリガ

トリガ・ステータスのチェック
トリガ・ステータスは、前面パネルのステータス・ランプまたはリードアウトでチェックできます。

Arm、Ready、Trig’d の各コントロール
をチェックして、トリガのステータスを
確認します。

Trig’d がオンの場合、機器は有効
なトリガを取り込み、波形のポストト
リガ部分の処理を実行しています。

Ready がオンの場合、機器は、有
効なトリガの発生を受け入れること
ができ、トリガを待機しています。
プリトリガのデータは取り込まれて
います。

Arm がオンの場合、トリガ回路は、
波形レコードのプリトリガ部分を処
理しています。

Trig’d と Ready がオンの場合は、
有効な A イベント・トリガが認識さ
れ、機器は遅延トリガを待機してい
ます。遅延トリガが認識されると、
遅延波形のポストトリガ部分が処
理されます。

Arm、Trig’d、Ready がオフの場
合、アクイジションは停止していま
す。

いくつかの主要なトリガ・パラメータの
設定をすばやく確認するには、表示
の下部でトリガ・リードアウトをチェック
します。リードアウトは、エッジ・トリガと
拡張トリガで異なります。

1. A トリガ・ソース = Ch1

2. トリガ・スロープ = 立上りエッジ

3. トリガ・レベル

4. 時間軸
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ピンポイント・トリガ

A（メイン）トリガおよび B（遅延）トリガの使用
単純な信号に対して A イベント（メイン）トリガを使用し、より複雑な信号を取り込むために B イベント（遅
延）トリガと組み合わせて使用することができます。トリガ・システムは、A イベントの発生後に、B イベン
トを検出してからトリガして波形を表示します。

A トリガ

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

B トリガ（遅延）

3. A →B Seq（A → B シーケンス）で
関数を選択します。

4. トリガ遅延時間または B イベント
数を設定します。
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ピンポイント・トリガ

5. B Event（遅延）タブで、B トリガの
特性を設定します。

6. Mode タブで、Normal Trigger Mode
および Holdoff を選択します。

B イベントに対するトリガ

A トリガが機器を動作可能にします。
ポストトリガ・アクイジションが、n 番目
の B イベントから開始されます。
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ピンポイント・トリガ

遅延時間を使用した B トリガ

A トリガが機器を動作可能にします。
ポストトリガ・アクイジションは、トリガ
遅延時間が経過した直後の B エッジ
で開始されます。

リセットによるトリガ

B トリガ・イベントが発生した場合に、ト
リガ・システムをリセットする条件を指
定できます。リセット・イベントが発生
した場合に、トリガ・システムは、B イ
ベントの待機を停止し、A イベントの
待機に戻ります。

ヒント

B トリガ遅延時間と水平遅延時間は、別々の機能です。A トリガのみを使用して、または A トリガと B ト
リガの両方を併用してトリガ設定を行う場合、水平遅延を併用すればアクイジションをさらに遅延さ
せることができます。
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ピンポイント・トリガ

トリガ時の電子メールの送信
以下の手順を実行する前に、イベント時の電子メールを設定する必要があります。(110 ページ 「イベ
ント時の電子メールの設定」 参照)。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. Mode タブを選択します。

3. E-mail on Trigger で On をクリック
してから、Setup をクリックします。
(110 ページ 「イベント時の電子
メールの設定」 参照)。

水平遅延の使用

トリガの場所から時間が大きく離れて
いるエリアで波形の詳細を取り込む場
合は、水平遅延を使用します。

1. Delay を押します。

2. 水平方向の Position コントロール
で遅延時間を調整するか、コント
ロール・ウィンドウで遅延時間を入
力します。

3. 水平方向の Scale を調整し、遅延
拡張ポイントの周辺で必要な詳細
を取り込みます。
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ピンポイント・トリガ

ヒント

遅延アクイジションの拡大には、MultiView Zoom と Horizontal Delay を併用します。

水平遅延の ON と OFF を切り替えると、トリガ位置近くの領域と遅延時間を中心とした領域の 2 つの
対象領域の信号詳細を素早く比較できます。
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波形の表示

波形の表示

このセクションでは、波形の表示の概念と手順について説明します。詳細については、オンライン・
ヘルプを参照してください。

表示スタイルの選択

表示スタイルを設定するには、Display
> Display Style をクリックしてから、次
のいずれかのスタイルを選択します。

レコード・ポイント間
が線で結ばれた波形
を表示します。

波形のレコード・ポイ
ントを画面上にドット
で表示します。

実際のサンプルを表
示します。補間され
たポイントは表示され
ません。
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波形の表示

表示パーシスタンスの設定

Display > Display Persistence を選択
してから、パーシスタンスのタイプを
選択します。

No persistence は、現在のアクイ
ジションの波形レコード・ポイント
だけを表示します。新しいそれぞ
れの波形レコードは、前に取り込
まれたチャンネルのレコードを置
き換えます。

Infinite persistence は、アクイジショ
ン・ディスプレイ設定の 1 つを変更
するまで、連続的にレコード・ポイ
ントを累積します。ノーマル・アクイ
ジション・エンベロープの外側にあ
るポイントの表示に使用します。

Variable persistence では、指定
された時間インターバルの間、レ
コード・ポイントを蓄積します。各レ
コード・ポイントは、タイム・インター
バルに従って個別に減衰します。

Reset persistence は、パーシスタ
ンスをクリアします。

1. 可変パーシスタンスの時間
を設定するには、Display >
Display Persistence > Persistence
Controls... を選択します。

2. Persist Time をクリックしてから、汎
用ノブを使って、残光時間を設定
します。
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波形の表示

表示フォーマットの設定
機器は、2 つの異なるフォーマットで波形を表示できます。目的に最もよく合うフォーマットを選択して
ください。

Display > Display Formatを選択しま
す。

Y-T フォーマットを選択すると、時
間の経過とともに変化する信号振
幅が表示されます。

X-Y フォーマットを選択すると、波
形レコードの振幅をポイントごとに
比較できます。

4 GHz 未満の機器では、 Ch 1 (X)
と Ch 2 (Y)、Ch 3 (X) と Ch 4 (Y)、
Ref 1 (X) と Ref 2 (Y)、あるいは
Ref 3 (X) と Ref 4 (Y) の各チャンネ
ルが比較されます。

4 GHz 以上の機器では、 Ch 1 (X)
と Ch 3 (Y)、Ch 2 (X) と Ch 4 (Y)、
Ref 1 (X) と Ref 2 (Y)、あるいは
Ref 3 (X) と Ref 4 (Y) の各チャンネ
ルが比較されます。

ヒント

XY フォーマットは、リサージュ・パターンなどの位相の関係を調べる場合に特に便利です。

XY フォーマットはドットだけの表示ですが、パーシスタンスを設定できます。XY フォーマットを選択した
場合は、Vector スタイルを選択しても無効になります。
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波形の表示

波形補間の選択

Display > Waveform Interpolation を選
択してから、次のいずれかを選択し
ます。

Sin(x)/x 補間法は、実際のサンプ
ル間の曲線を使用してレコード・ポ
イントを計算します。

直線補間法は、直線を使用して、
実際の取り込みサンプルの間のレ
コード・ポイントを計算します。

ヒント

Sin(x)/x 補間は、デフォルトの補間モードです。このモードは、波形を正確に表すのに必要な実際のサ
ンプル・ポイントが直線補間より少なくて済みます。
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波形の表示

スクリーン・テキストの追加

1. Display > Screen Text を選択しま
す。

2. 最大 8 つの独立したテキスト行を
入力できます。

3. Display をクリックし、テキスト表示
のオンとオフを切り替えます。

4. Properties をクリックし、Text
Properties コントロール・ウィンドウ
を開き、ディスプレイにテキストを表
示する位置を指定します。

5. Clear をクリックして、選択した行の
テキスト全体を消去します。

ヒント

画面のテキストをクリックしてドラッグすると、画面上の位置を変更できます。
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波形の表示

目盛スタイルの選択

目盛スタイルを設定するには、 Display
> Graticule Style を選択し、以下のい
ずれかのスタイルを選択します。

波形パラメータをす
ばやく測定するため
に使用します。

クロスヘアが不要な
場合に、カーソルや
自動リードアウトによ
る全画面測定に使用
します。

このスタイルは、自
動リードアウトなどの
データを表示する領
域を残したまま、波形
パラメータをすばやく
測定するために使用
します。

ディスプレイ機能が
不要な場合に、自動
リードアウトなどのスク
リーン・テキストと共に
使用します。

ディスプレイ機能が
不要な場合に、自動
リードアウトなどのスク
リーン・テキストと共に
使用します。

ディスプレイ機能が
不要な場合に、自動
リードアウトなどのスク
リーン・テキストと共に
使用します。
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波形の表示

トリガ・レベル・マーカの設定

1. Display > Objects... を選択します。

2. 以下のいずれかを選択します。

Short は、目盛の片側に短い矢
印を表示します。

Long は、目盛全体にわたる水
平線を表示します。

Off は、トリガ・レベル・マーカを
オフにします。

日付と時刻の表示

1. Display > Objects... を選択します。

2. 目盛にある日時の表示を切り換え
ます。Utilities メニューを使って、
日時を設定します。
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波形の表示

カラー・パレットの使用

Display > Record View Paletteまたは
FastAcq/WfmDB Palette を選択して
から、次に示す波形および目盛のカ
ラー・スキームのいずれかを選択しま
す。

Normal は、全体的に最適な色調
と明るさのレベルで表示します。各
チャンネル波形の色は、前面パネ
ルにあるそれぞれの垂直ノブの色
に対応しています。

Temperature Grading は、サンプ
ル密度の最も高い波形エリアを赤
の影で表示します。サンプル密度
の最も低いエリアは、青の影で表
示されます。

Monochrome Green は、サンプル
密度の最も高い波形エリアを明る
い緑の影で表示します。サンプル
密度の最も低いエリアは、暗い緑
の影で表示されます。アナログ・オ
シロスコープのディスプレイに最も
近いモードです。

Spectral Grading は、サンプル密
度の最も高い波形エリアを青の影
で表示します。サンプル密度の最
も低いエリアは、赤の影で表示さ
れます。

Monochrome Gray は、サンプル密
度が最も高い波形エリアを明るい
グレーの影で表示します。サンプ
ル密度が最も低いエリアは、暗い
グレーの影で表示されます。

User は、ユーザが定義した色で波
形を表示します。

ヒント

Display > Colors コントロール・ウィンドウのカラー・グレーディング・パレットの 1 つを選択すると、サン
プル密度により色分けされた表示になります。

Record View 用と FastAcq/WfmDB 用の 2 つのカラー・パレットがあります。
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リファレンス波形カラーの設定

Display > Colors... を選択してから、
次のいずれかを選択します。

Default は、リファレンス波形にデ
フォルトのシステム・カラーを使用
します。

Inherit は、リファレンス波形に元の
波形と同じカラーを使用します。

演算波形のカラーの設定

Display > Colors... を選択してから、
次のいずれかを選択します。

Default は、演算波形にデフォルト
のシステム・カラーを使用します。

Inherit は、演算波形に対して演
算関数の基になる 1 番小さい番
号のチャンネル波形と同じ色を使
用します。

ヒント

演算およびリファレンス波形のデフォルト・カラーは、各波形で異なります。

MultiView ズームの使用
取り込んだ波形を垂直方向、水平方向、または両方向に拡大する場合は、MultiView ズーム機能を使用し
ます。ズームした波形は、整列またはロックさせたり、自動的にスクロールさせること もできます。スケーリン
グと位置は、表示のみに影響し、実際の波形データには影響しません。

1. MultiView Zoom を押して、画面を
分割し、ズームの目盛を追加しま
す。
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2. Horiz または Vertを押して、ズー
ムの目盛で拡大する軸を選択しま
す。ズーム波形のスケールと位置
を調整するには、汎用ノブを使用
します。

3. ズーム目盛のサイズを調整するに
は、Vertical または Horiz/Acq メ
ニューから Zoom Graticule Size を
選択します。

4. ズームをオフにするには、前面パ
ネルのボタンを押します。

ヒント

Zoom Setup メニューを使用して、ズームされる波形の目盛サイズを変更することもできます。
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複数エリアのズーム
1 つのレコード内の複数の領域を同時に表示し、比較する場合は、次の手順を使用します。

1. ズームする波形領域の周りをクリッ
クし、四角にドラッグします。

2. Zoom 1 On を選択します。

3. ズームするもう一つの波形領域の
周りをクリックし、四角にドラッグし
てから、Zoom 2 On を選択します。

4. ズームしたエリアを水平方向に調
整するには、Zoom ボックスの下に
ある水平マーカをクリックし、ズー
ムしたエリアを選択します。

5. 汎用ノブを使って、選択したズー
ム・エリアの水平位置と倍率を調
整します。
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6. ズームした領域を垂直方向に調整
するには、Vertical > Zoom Setup...
を選択して、垂直フィールドをクリッ
クし、汎用ノブを使用して Vertical
Position と Factor を調整します。

ヒント

ズーム・エリアをクリアするには、Zoom Setup コントロール・ウィンドウから、Position Factor Reset を
クリックします。

Zoom Setup コントロール・ウィンドウから、各ズーム表示をオンまたはオフにできます。

MultiView Zoom ボタンを押して、すべてのズーム表示のオンとオフを切り替えます。

ズームしたエリアを水平方向に移動するには、Zoom ボックスの下にある水平マーカをクリックし、
ドラッグします。
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ズームした波形のロックおよびスクロール

1. Lock and Scroll を使用するには、
Vertical または Horiz/Acq メニュー
のいずれかで Zoom Setup... を選
択してから、Lock and Scroll タブを
選択します。

2. 単一のズームした領域をスクロール
するには、Zoom 1-4 チェック・ボッ
クスを選択してから、Auto Scroll ボ
タンをクリックします。

3. 複数のズームした領域を同時にス
クロールするには、Lock をクリック
してから、スクロールする Zoom 1-4
チェック・ボックスを選択します。

ズームした領域をロックすると、そ
の相対的な水平位置がロックされ
ます。1 つのロックおよびズームし
た領域の水平位置を変更すると、
すべての水平位置が変わります。

ヒント

複数のズーム・エリアが選択され、ロックされていない場合、一番上の番号のズーム・エリアがオートスク
ロールされ、その他のエリアは静止したままになります。

DPO7000 シリーズおよび DPO70000 シリーズ・クイック・スタート・ユーザ・マニュアル 59



波形の解析

波形の解析

この機器は、波形解析に役立つ機能（カーソル、自動測定、統計、ヒストグラム、演算、スペクトラム解析、
および詳細な合否テスト）を備えています。 ここでは、波形解析の概念および手順について説明しま
す。 詳細情報は、オンライン・ヘルプで参照することができます。

自動測定の実行

1. Measure > Measurement Setup...
を選択します。

2. 測定するチャンネル波形、演算波
形、またはリファレンス波形を選択
します。

3. タブを使用して、5 つの異なるカテ
ゴリの測定を選択します。
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4. すべての測定を削除するには、
Clear All をクリックします。

5. 複数の測定を削除するには、クリッ
クおよびドラッグして測定を選択し、
Clear Selected をクリックします。

Measure メニューで波形の測定方
法を直接選択することもできます。
(62 ページ 「自動測定一覧」 参
照)。

ヒント

ロール・モードでは、アクイジションを停止するまで測定値を利用できません。
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自動測定一覧
次の表は、Amplitude、Time、More、Histogram、またはCommunicationのカテゴリ別に各自動測定の一覧を
示したものです。(60 ページ 「自動測定の実行」 参照)。

振幅測定

測定 説明

Amplitude 波形全体またはゲート範囲で測定されるハイ値とロー値の差です。

High この値は、立下り時間や立上り時間の測定などで、高基準、中基準、低基準値が必
要な場合に 100% として使用されます。 この値の計算には、最小 / 最大方式またはヒ
ストグラム方式を使用できます。最小 / 最大方式では、検出された最大値を使用しま
す。ヒストグラム方式では、中点より上で最も頻繁に出現する値を使用します。 この値
は、波形全体またはゲート領域全体について測定されます。

Low この値は、立下り時間や立上り時間の測定などで、高基準、中基準、低基準値が必
要な場合に 0% として使用されます。この値の計算には、最小 / 最大方式またはヒス
トグラム方式を使用できます。最小 / 最大方式では、検出された最小値を使用しま
す。ヒストグラム方式では、中点より下で最も頻繁に発生する値を使用します。この値
は、波形全体またはゲート領域全体について測定されます。

RMS 波形全体またはゲート範囲の電圧の二乗平均値（RMS）です。

Max 通常は、正の最大ピークの電圧です。 Max は、波形全体またはゲート領域全体に
ついて測定されます。

Min 通常は、負の最大ピークの電圧です。 Min は、波形全体またはゲート領域全体に
ついて測定されます。

Pk-Pk 波形全体またはゲート範囲における最大振幅と最小振幅の絶対差です。

Cycle RMS 波形の最初のサイクルまたはゲート範囲の最初のサイクルの電圧の二乗平均値
（RMS）です。

+Overshoot この値は、波形全体またはゲート領域全体について測定され、次の式で表されます。
正のオーバシュート =（（最大値 － ハイ値）／振幅） × 100%。

-Overshoot この値は、波形全体またはゲート領域全体について測定され、次の式で表されます。
負のオーバシュート =（（ロー値 - 最小値）／振幅） x 100%。

Mean 波形全体またはゲート範囲の相加平均です。

Cycle Mean 波形の最初のサイクルまたはゲート範囲の最初のサイクルの相加平均です。

時間測定

測定 説明

Rise Time 波形またはゲート領域の最初のパルスの立上りエッジで、低基準値（デフォルト =
10%）から最終値の高基準値（デフォルト = 90%）まで上昇するのに要する時間です。

Fall Time 波形またはゲート領域の最初のパルスの立下りエッジで、高基準値（デフォルト =
90%）から最終値の低基準値（デフォルト = 10%）まで下降するのに要する時間です。

Pos Width 正パルスの中基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形また
はゲート領域の最初のパルスで測定されます。

Neg Width 負パルスの中基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形また
はゲート領域の最初のパルスで測定されます。
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時間測定 （続く）

測定 説明

+ Duty Cyc 信号周期に対する正のパルス幅の比率をパーセンテージで表します。デューティ・サ
イクルは、波形またはゲート領域の最初のサイクルで測定されます。

- Duty Cyc 信号周期に対する負のパルス幅の比率をパーセンテージで表します。デューティ・サ
イクルは、波形またはゲート領域の最初のサイクルで測定されます。

Period 波形またはゲート領域の最初のサイクルを完了するのに要する時間です。Period
は周波数の逆数で、単位は秒です。

Freq 波形領域またはゲート領域にある最初のサイクルの周波数。周波数は周期の逆数で
す。単位はヘルツ（Hz）で、1 Hz は 1 サイクル／秒です。

Delay 2 つの異なる波形にある中基準（デフォルトは 50%）振幅ポイント間の時間です。

詳細測定

測定 説明

Area 波形全体またはゲート範囲の領域を電圧 - 秒で表します。グランドより上の測定領域
は正、グランドより下の測定領域は負です。

Cycle area 波形の最初のサイクルまたはゲート範囲の最初のサイクルの領域を電圧 - 秒で表し
ます。共通基準ポイントより上の領域は正、下の領域は負となります。

Phase 波形の一方が他方よりも先行または遅延する時間量を角度で表します。360°が 1
波形サイクルに相当します。

Burst Width 波形全体またはゲート領域全体について測定されたバースト（一連の過渡的現
象）の継続時間です。

ヒストグラム測定

測定 説明

Wfm Ct ヒストグラムに含まれる波形数。

Hits in Box ヒストグラム・ボックス内またはボックス上のポイント数。

ピーク・ヒット数
（Peak Hits）

ヒストグラムの最大ビンに含まれるポイント数。

Median ヒストグラム・ボックスの中点を表示します。ヒストグラム・ボックス内またはボックス上で
取り込んだすべてのポイントの半分はこの値より下、半分はこの値より上になります。

Max 垂直ヒストグラムにはゼロ以外の最も高いビンの電圧、水平ヒストグラムにはゼロ以外
の最も右側にあるビンの時間が表示されます。

Min 垂直ヒストグラムにはゼロ以外の最も低いビンの電圧、水平ヒストグラムにはゼロ以外
の最も左側にあるビンの時間が表示されます。

Pk-Pk（ピーク・
ツー・ピーク）

ヒストグラムのピークからピークまでの値。垂直ヒストグラムには、ゼロ以外の最高ビン
の電圧からゼロ以外の最低ビンの電圧を引いた値が表示されます。水平ヒストグラ
ムには、ゼロ以外の最も右側にあるビンの時間からゼロ以外の最も左側にあるビ
ンの時間を引いた値が表示されます。

Mean ヒストグラム・ボックス内またはボックス上のすべてのポイントを取り込み、平均を
測定します。
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ヒストグラム測定 （続く）

測定 説明

Std Dev ヒストグラム・ボックス内またはボックス上で取り込んだすべてのポイントの標準偏差
（実効値（RMS）偏差）を測定します。

Mean ± 1 Std
Dev

ヒストグラム内で、ヒストグラム平均から 1 標準偏差内にあるポイントのパーセン
テージを表示します。

Mean ± 2 Std
Dev

ヒストグラム内で、ヒストグラム平均から 2 標準偏差内にあるポイントのパーセン
テージを表示します。

Mean ± 3 Std
Dev

ヒストグラム内で、ヒストグラム平均から 3 標準偏差内にあるポイントのパーセン
テージを表示します。

コミュニケーション測定

測定 説明

Ext Ratio アイ・トップからアイ・ベースまでの比率。この測定は、波形データベースまたは波形
データベース・モードで保存されたリファレンス波形に対してのみ有効です。

Ext Ratio % アイ・ベースからアイ・トップまでの比率をパーセンテージで表します。この測定
は、波形データベースまたは波形データベース・モードで保存されたリファレンス
波形に対してのみ有効です。

Ext Ratio（dB） アイ・ベースに対するアイ・トップの比率をデシベル数で表します。この測定は、波
形データベースまたは波形データベース・モードで保存されたリファレンス波形に
対してのみ有効です。

Eye Height アイ高さの測定値（ボルト）です。

Eye Width アイ幅の測定値（秒）です。

Eye Top 消光比の測定に使用される最高値です。

Eye Base 消光比の測定に使用される最低値です。

Crossing % アイ交差ポイントをアイ高さのパーセンテージとして表します。

Jitter P-P エッジ・ジッタのピークからピークまでの値を現在の水平軸の単位で表したものです。

Jitter RMS エッジ・ジッタの RMS 値を現在の水平軸の単位で表したものです。

Jitter 6 Sigma エッジ・ジッタの RMS 値の 6 倍を現在の水平軸の単位で表したものです。

Noise P-P ユーザが指定した信号のトップまたはベースのノイズのピーク・ピーク値。

Noise RMS ユーザが指定した信号のトップまたはベースのノイズの RMS 値。

S/N Ratio ユーザが指定した信号のトップまたはベースのノイズに対する信号振幅の比率。

Cyc Distortion 最初のアイ交差のピーク・ツー・ピークの時間変動を、アイ周期のパーセントとして
中基準で測定したものです。

Q-Factor ノイズに対するアイ・サイズの比率です。
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自動測定のカスタマイズ
ゲートの使用、測定統計の修正、または測定基準レベルの調整により、自動測定をカスタマイズできます。

ゲート

ゲートを使用して、測定を波形の特定
部分に限定します。

1. Measure > Gating > Gating ... を
選択します。

2. ゲートの位置を設定するには、次
のいずれかの操作を行います。

Cursor をクリックして、カーソル
とカーソルの間の領域をゲート
領域に設定します。

Zoom (1-4) をクリックして、
Zoom （1～4）目盛に対する
ゲート領域を設定します。
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統計

統計は測定時に自動的にオンになり
ます。統計により測定の安定性を評価
することができます。

1. 表示されている統計を変更するに
は、Measure > Statistics を選択し
てから、Mean または All を選択し
ます。（All には、最小値、最大値、
平均値、標準偏差、および母集団
が含まれます。）

2. 統計を削除するには、Off を選択
します。

スナップショット

ある一時点における有効なすべての
測定の状態を確認するには、Measure
> Snapshot を選択します。

一般的な測定または通信測定のス
ナップショットの取得を選択するには、
General または Comm を選択します。
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測定のコメント

1. 測定にコメントを付けるには、
Measurements Setup コントロール・
ウィンドウで、Annotation を選択し
ます。ドロップダウン・リストから、コ
メントを付ける測定を選択します。

2. 測定コメントの記述量を選択す
るには、Measure > Annotation >
Standard または Detailed を選択
します。

DPO7000 シリーズおよび DPO70000 シリーズ・クイック・スタート・ユーザ・マニュアル 67



波形の解析

基準レベル

基準レベルによって、時間関連の測
定の取り込み方法が決定されます。

1. Measure > Reference Levels... を
選択します。

2. 測定基準レベルを別の相対値また
は絶対値に調整します。

立上り時間や立下り時間の計
算には、High 基準および Low
基準が使用されます。デフォル
トの High 基準は 90%、Low 基
準は 10% です。

Mid 基準は、主にパルス幅など
のエッジ間の測定に使用しま
す。デフォルトのレベルは 50%
です。

Mid2 基準は、遅延または位相
の測定で指定された 2 番目の
波形に使用されます。デフォル
トのレベルは 50% です。

ヒント

ノイズ値の正確度を保証するには、アイ信号の測定時に信号タイプを必ず Eye に設定してください。
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カーソル測定の実行
カーソルを使用して、取り込んだデータで測定を実行します。

1. Cursors を押します。

2. Cursor Source を選択します。

3. 次の中からカーソル・タイプを 1 つ
選択します。

H Bar は、振幅（一般的にはボ
ルトまたはアンペア単位）を測
定します。

V Bar は、水平軸パラメータ（一
般的には時間）を測定します。

Waveform カーソルおよび
Screen カーソルは、垂直軸パラ
メータと水平軸パラメータを同時
に測定します。Waveform カー
ソルは波形に接触し、Screen
カーソルは波形に接触せずに
浮かんだ状態になります。
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4. 2 つの波形間の測定を行うには、
Waveform を選択して、各カーソル
に対する波形ソースを選択します。

5. Cursors > Cursor Position... を選
択し、汎用ノブを使用してカーソル
位置を調整します。

6. 表示されるカーソル測定結果を確
認します。

ヒント

複数のカーソルが並んで移動するように設定するには、Cursor Track Mode を使用します。各カーソ
ルを別々に移動するには、独立カーソル・モードを使用します。

ズーム目盛を使用すると、カーソルを波形の特定ポイントに直接配置し、精密な測定を行うことが
できます。

また、カーソルをクリックおよびドラッグして、別の位置へ移動することもできます。

トリガ・ポイントから垂直カーソルまでの時間は、垂直カーソルで測定されます。

70 DPO7000 シリーズおよび DPO70000 シリーズ・クイック・スタート・ユーザ・マニュアル



波形の解析

ヒストグラムの設定
垂直（電圧）または水平（時間）のいずれか一方のヒストグラムを表示できます。1 つの軸に沿って波形の統
計的測定データを取得するには、ヒストグラム測定を使用します。

1. ヒストグラムの対象になる波形セグ
メントを横切るようにポインタをクリッ
クし、ドラッグします。たとえば、水
平ヒストグラムの高さより高いボック
スを作成します。

2. ショートカット・メニューか
ら、Histogram Vertical または
Histogram Horizontal を選択しま
す。

3. 目盛の上部（水平ヒストグラムの場
合）または左端（垂直ヒストグラム
の場合）にヒストグラムを表示され
ます。
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4. ヒストグラムのスケール、またはヒス
トグラム・ボックスのサイズおよび
位置を調整するには、Measure >
Waveform Histograms を選択して、
Histogram Setup コントロール・ウィ
ンドウを使用します。

5. また、ヒストグラム・データを自動測
定することもできます。(60 ページ
「自動測定の実行」 参照)。

ヒント

垂直ヒストグラムは信号ノイズの測定、水平ヒストグラムは信号ジッタの測定に使用します。

ショートカット・メニューをアクティブにして、ヒストグラムの表示をオフにする場合は、クリックおよびド
ラッグの手順を使用します。
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演算波形の使用
チャンネル波形やリファレンス波形の解析をサポートするには、演算波形を作成します。ソース波形などの
データの組み合わせや変換により、アプリケーションに必要なデータ表示を導き出すことができます。

あらかじめ定義されている演算式の場合は、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。

2. あらかじめ定義されている数値式
の 1 つを選択します。

高度な演算波形式を作成するには、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。
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2. Editor をクリックします。

3. ソース、演算子、定数、測定、変
数、および関数を使用して高度な
演算波形式を作成します。

4. 条件に合った式が定義されたら、
Apply をクリックします。

5. 独自のフィルタを追加するには、
Filter タブをクリックします。Load
をクリックします。
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6. Math Arbitrary Filters フォルダを
ダブルクリックします。使用するフィ
ルタのフォルダをダブルクリックし
ます。使用するフィルタをダブルク
リックします。

7. 選択したフィルタを使用して、演算
式を作成します。

8. 条件に合った式が定義されたら、
Apply をクリックします。

ヒント

ソースが無効の場合、演算定義は作成されません。

演算波形は、チャンネル波形、リファレンス波形、演算ソース波形および測定値を基にして作成
することができます。

演算波形に対する測定は、チャンネル波形と同じ方法で行うことができます。

演算波形の水平スケールおよび位置は、演算式のソースから導き出されます。ソース波形のこれらのコ
ントロールを調整すると、演算波形も調整されます。

演算波形を拡大するには、MultiView Zoom を使用します。ズーム領域の位置を調整するには、
マウスを使用します。

任意の演算フィルタの詳細については、オンライン・ヘルプを参照してください。
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スペクトラム解析の使用
定義済みスペクトラム演算式には、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。

2. あらかじめ定義されているスペクト
ラム演算式の 1 つを選択します。

3. Basic をクリックします。

4. Resolution BW または Frequency
Span をクリックし、キーパッドあるい
は汎用ノブを使用して、スペクトラ
ムの表示を調整します。

高度なスペクトラム演算式を作成するには、次の手順を使用します。
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1. Math > Advanced Spectral... を選
択します。

2. 定義する演算波形を選択します。

3. 作成するスペクトラム波形のタイプ
をクリックします。波形を定義しな
おすには、Clear をクリックします。

4. ソース波形を選択します。

5. Spectral Setup コントロール・ウィン
ドウのコントロールを使用してスペ
クトラムの波形を調整し、汎用ノブ
を使用します。

6. 時間領域と周波数領域の波形を
同時に表示できます。

Gating を使用して、スペクトラム解
析の対象として時間領域波形の一
部分のみを選択します。 (65 ペー
ジ 「ゲート」 参照)。
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ヒント

スペクトラム演算波形のソースは、チャンネル波形または他の演算波形である必要があります。

短いレコード長を使用すると、機器の応答が速くなります。

長いレコード長を使用すると、信号に対してノイズが低減するため、周波数分解能が向上します。

ウィンドウ関数が異なると、スペクトラムのフィルタ・レスポンスの形状が異なり、分解能帯域幅も異なる結
果になります。詳細についてはオンライン・ヘルプを参照してください。

ゲート幅は分解能帯域幅（RBW）により直接制御されます。このため、コントロールを調整すると、時
間領域ゲート・マーカも移動します。

スペクトラムの実数データまたは虚数データの線形振幅を表示できます。これは、スペクトラムをオフラ
インで処理し、時間領域トレースに変換する場合に便利です。

マスク・テストの使用
シリアル・コミュニケーション・マスク・テスト（オプション MTM 型または MTH型）では、あらかじめ定義された
テンプレートまたはマスクと信号を比較することができます。 信号がテストに合格するには、マスクにより定
義されたセグメントの範囲外になっている必要があります。 一般的に、マスクは ANSI などの標準規格委員
会によって定義されます。 マスク・テストを実行するには、次の操作を行います。

1. Masks > Source... を選択します。

2. 信号ソースを選択します。
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3. Masks タブをクリックします。

4. Type および Standard を選択しま
す。

5. Config をクリックして、Mask
Configuration コントロール・ウィン
ドウにアクセスします。このコント
ロール・ウィンドウでは、マスクと違
反の表示の仕方、およびマスクの
Autoset と Autofit の設定値を調整
することができます。

6. Masks をクリックして、Mask Setup
コントロール・ウィンドウに戻ります。

7. Lock Mask to Wfm をクリックして
On にし、水平軸または垂直軸の
設定の変更に合わせてマスクが変
更されるようにします。

8. Hit Count をクリックして On にし、
マスク・テスト中に違反がハイライト
表示されるようにします。
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9. Autoset をクリックし、入力信号の
特性に基づいて、波形がマスクと
自動的に揃うようにします。

10.Autofit をクリックして On にし、各
アクイジション後に波形位置が自
動的に変更され、ヒット数が最小限
に抑えられるようにします。

11.Tolerance タブをクリックして、公差
を設定します。

公差の設定を 0% より大きくする
と、マスク・テストに通過しづらくな
ります。設定を 0% より小さくする
と、マスク・テストの通過が容易に
なります。

標準で指定されたとおりのマスクが
必要な場合は、0% を使用してくだ
さい。パーセンテージを変更するこ
とにより、マージン・テストを実施す
ることができます。

12.Pass/Fail Setup タブをクリックして、
合否パラメータを設定します （ア
クイジション・モードが Waveform
Database のときは、# of Wfms ラベ
ルが Samples になります）。

13.Pass/Fail Test Notifications を選
択します。
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14.テストする極性を選択します。

15.Pass/Fail Test をクリックして On に
すると、マスク・テストが開始され
ます。

16.Repeat をクリックして On にする
と、マスク・テストが連続的に実行
されます。

17.テスト終了時の通知方法を選択し
ます。

18.Pass/Fail Results タブをクリックす
ると、テスト結果が表示されます。

19.Pass/Fail Test をクリックし、On に
すると、マスク・テストが開始され
ます。

20.合計をリセットし、すべての違反
をクリアするには、Resetをクリック
します。

ヒント

マスク内に信号が存在しない場合、Autoset を有効にして、マスク内の中央に波形を配置します。
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MyScope 機能

MyScope 機能では、日常的に使用するコントロールのみで構成されたカスタム・コントロール・ウィンドウを
作成できます。いくつかのコントロール・ウィンドウを切り替えるのではなく、使用するコントロールを 1 つの
カスタム・コントロール・ウィンドウに配置します。

このセクションでは、MyScope コントロール・ウィンドウを作成および使用する手順について説明します。詳
細情報はオンライン・ヘルプで参照できます。

新しい MyScope コントロール・ウィンドウの作成

1. Select MyScope > New Control
Window...を選択します。

2. + をクリックして、カテゴリを展開し
ます。MyScope コントロール・ウィン
ドウに追加できるコントロールが、
それぞれのカテゴリ内に表示され
ます。これらのカテゴリはメニュー・
バーと同じ配置で表示されるため、
よく使用するコントロールを簡単に
見つけることができます。
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3. ファイルに保存された波形を呼び
出すにはまず、波形が呼び出され
るリファレンス保存場所（Ref 1 ～
Ref 4）を選択します。

4. コントロールをダブルクリックする
か、または+ をクリックし、コントロー
ル・リストを展開します（+ （プラス記
号）がない場合は、コントロールを
それ以上カスタマイズできません）。
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5. チェック・ボックスをオフにして、コ
ントロールに表示しないコンポーネ
ントを削除します。

6. コントロールをクリックし、MyScope
コントロール・ウィンドウまでドラッグ
します。マウス・ボタンを離すと、最
も近いグリッド位置にコントロール
が配置されます。コントロールをク
リックしてドラッグすると、MyScope
コントロール・ウィンドウ内のコント
ロールの配置を変更できます。
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7. New Tab をクリックし、MyScope コ
ントロール・ウィンドウにタブを追
加します。最大 6 つのタブを設定
できます。

8. タブの名前を変更するには、次の
いずれかの操作を行います。

Rename Tab をクリックします。

タブをダブルクリックして、新し
い名前を入力します。

9. User Pref... をクリックし、MyScope
コントロール・ウィンドウにロードす
るユーザ設定を指定します。

10.コントロールを削除するには、次の
いずれかの操作を行います。

タブを選択し、Delete をクリック
します。 タブとすべてのコント
ロールが削除されます。

コントロールを選択し、Delete
をクリックします。選択したコント
ロールだけが削除されます。

11.Save をクリックし、MyScope コント
ロール・ウィンドウの名前を入力す
るか、またはデフォルトの名前を使
用します。

ヒント

コントロールを再設定するには、コントロールをクリックし、プレビュー・ウィンドウまでドラッグして戻し
ます。次に、チェック・ボックスをオンまたはオフにして、コントロール内のコンポーネントを選択また
は選択解除します。
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タブの順番を変更するには、タブをクリックして新しい位置までドラッグします。

コントロールを削除するには、コントロールをクリックして、画面の上半分（MyScope コントロール・
ウィンドウの外側）までドラッグします。

MyScope コントロール・ウィンドウの使用
以前に定義した MyScope コントロール・ウィンドウを開くには、次の手順を実行します。

1. Select MyScope > Open Control
Window... を選択するか、または最
近使用した 5 つの MyScope ウィン
ドウの 1 つを選択します。

2. 使用するコントロール・ウィンドウを
選択し、Open をクリックします。
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アクティブな MyScope コントロール・ウィンドウを表示するには、次の手順を実行します。

1. MyScope > Current... を選択する
か、ツールバー・モードで MyScope
をクリックします（MyScope コント
ロール・ウィンドウは、表示されてい
なくても有効になっています）。

MyScope コントロール・ウィンドウを編集するには、次の操作を行います。

1. MyScope > Edit Control Window...
を選択します。

2. 編集するコントロール・ウィンドウを
選択し、Open をクリックします。
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Quick Tips

コントロールによっては、MyScope コントロール・ウィンドウと標準のコントロール・ウィンドウで動作が異な
る場合があります。詳細については、オンライン・ヘルプを参照してください。

MyScope コントロール・ウィンドウ（.tcw ファイル）は、他の DPO7000 シリーズの機器にコピーできます。
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情報の保存と呼び出し

このセクションでは、画面表示とセットアップの保存および呼び出し、測定の保存、クリップボードの使用、
および機器での印刷の手順について説明します。詳細については、オンライン・ヘルプで参照できます。

画面表示の保存

1. File > Save または Save As > Screen
Capture... を選択します。

2. Palette、View、Image、あるいは
Screen Capture Format オプショ
ンをセットアップする場合は、
Options... をクリックし、セットアッ
プしない場合は、ステップ 3 に進
みます。
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3. 画面表示を保存する場所を選択
します。

4. 画面表示の名前を入力するか、ま
たはデフォルトの名前を使用して、
ファイルの種類を選択します。

5. Save をクリックします。

ヒント

複数の画面表示をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をク
リックします。これで、前面パネルの Print ボタンを押すことにより、画面表示を保存できるようになります。

波形の保存

1. 波形を保存するには、File > Save
または Save As > Waveform... を
選択します。
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2. Waveform をクリックします。

3. Waveform Data Range、FastFrame
Data Range、Waveform Detail、
Data Destination、Source、あるいは
Data Ordering を指定する場合は、
Options... をクリックし、指定しない
場合は、ステップ 4 に進みます。

4. Source を選択します。

5. 波形は、リファレンス波形として機
器のメモリに保存することも、wfm
ファイル形式で Windows ディレクト
リに保存することもできます。波形
をリファレンスとして保存するには、
Ref 1 ～ 4 を選択します。 .wfm ファ
イル形式で保存するには、波形を
保存する場所を選択します。

6. .wfm ファイル形式で保存する場合
は、ファイル名を入力するか、デ
フォルトの名前を使用します。

7. Save をクリックします。

ヒント

類似する波形を多数保存する場合は、Auto-increment file name を選択すると、完全な名前を再入
力する必要はありません。

複数の波形をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をクリック
します。これで、前面パネルの Print ボタンを押すことにより、波形を保存できるようになります。
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波形の呼び出し

1. File > Recall... を選択します。

2. Waveform をクリックします。

3. 波形の呼び出し先を、Destination
で選択します。

4. 呼び出す波形を選択します。

5. Recall をクリックします。Recall をク
リックすると、リファレンス波形がオ
ンになり、Reference Waveform コ
ントロール・ウィンドウがアクティブ
になります。

6. コントロールを使用して、リファ
レンス波形を調整します。File >
Reference Waveform Controls... を
選択して、Reference Waveform コ
ントロール・ウィンドウにアクセスす
ることもできます。

ヒント

保存可能なファイルにはさまざまな種類がありますが、呼び出せるのは設定（*.set）ファイルおよ
び波形（*.wfm）ファイルのみです。
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機器設定の保存

1. File > Save または Save As >
Setup... を選択します。

2. Setup をクリックします。

3. 設定を保存する場所を選択しま
す。設定は、10 個の設定ストレー
ジ位置のうちの 1 つとして機器のメ
モリに保存することも、.set ファイル
形式で Windows ディレクトリに保
存することもできます。

4. ファイル名を入力するか、デフォル
トの名前を使用します。ポップアッ
プ・キーボードを使用して、機器
のメモリに保存された設定に対し
て名前を入力します。

5. Save をクリックします。

ヒント

タッチ・スクリーンが有効な場合は、容易に識別できるようにポップアップ・キーボードを使用してその
設定にラベルを付けます。

類似するファイルを多数保存する場合は、Auto-increment file name を使用すると、完全なファイル
名を再入力する必要はありません。

複数の設定をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をクリック
します。これで、前面パネルの Print ボタンを押すことにより、設定を保存できるようになります。
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情報の保存と呼び出し

機器設定の呼び出し

1. File > Recall... を選択します。

2. Setup をクリックします。

3. 呼び出す設定を選択します。設定
ファイルは、機器のメモリの 10 個
の位置のうちの 1 つから、または
Windows ディレクトリから呼び出す
ことができます。

4. Recall をクリックします。

ヒント

ディスク上に保存されている設定は、呼び出して、内部設定ストレージ位置に保存すると簡単に
使用できます。
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情報の保存と呼び出し

測定の保存

1. File > Save または Save As >
Measurement... を選択します。

2. Displayed Measurements または
Measurement Format を指定する
場合は Options... をクリックし、指
定しない場合は、ステップ 3 に進
みます。

3. 測定を保存する場所を選択しま
す。

4. 測定の名前を入力し、ファイルの
種類を選択します。

5. Save をクリックします。
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情報の保存と呼び出し

クリップボードへの結果のコピー
Microsoft クリップボードにコピーする画像、波形、または測定値の出力内容およびフォーマットを設
定するには、次の手順を使用します。

1. Edit > Copy Setup... を選択しま
す。

2. Images、Waveforms、あるいは
Measurements タブをクリックして、
目的のオプションを選択します。
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情報の保存と呼び出し

画像、波形、または測定値をコピーするには、次の手順を使用します。

1. コピーする項目を選択します。

2. Edit > Copy を選択するか、または
Ctrl + C を押します。

3. Ctrl + V を押して、Windows アプ
リケーションにその項目を貼り付
けます。

ハードコピーの印刷

1. ハードコピーを印刷するには、次
のいずれかの手順を実行します。

PRINT を押します。

File > Print を選択します。必要
な場合は、Page Setup ダイアロ
グ・ボックスで、ページの方向
を変更します。
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情報の保存と呼び出し

Print ダイアログ・ボックスおよび Page
Setup ダイアログ・ボックスは、使用し
ているプリンタにより異なります。

2. Page Setup... をクリックします。

3. 印刷パラメータを選択します。
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アプリケーション・ソフトウェアの実行

アプリケーション・ソフトウェアの実行

『オプショナル・アプリケーション・ソフトウェア CD』 には、機器にインストールして 5 回試用できるオプション
の無償アプリケーション・ソフトウェアが収録されています。これらのアプリケーションには、アプリケーション
固有の測定ソリューションが用意されています。以下にいくつかの例を示します。追加のパッケージが使用
できる場合もあります。詳細については、当社の担当者にお問い合わせいただくか、Tektronix のホーム
ページ（www.tektronix.com）にアクセスしてください。

ITU-T G.703 および ANSI T1.102 通信規格に対するマスクおよび測定適合性試験を実行する場
合は、CP2 を使用します。

DVI 物理層の適合性試験を実行する場合は、DVI 適合性試験ソリューション・ソフトウェアを使用します。

10/100/1000 Base-T イーサネット適合性試験を実行する場合は、ET3 を使用します。

FB-DIMM 適合性試験を実行するには、FBD RTE モジュールを使用します（≥4 GHz モデルの場合）。

HDMI 適合性試験を実行するには、HT3 HDMI 適合性試験ソフトウェアを使用します。

InfiniBand を実行するには、IBA RTE モジュールを使用します（≥4 GHz モデルの場合）。

IDEMA の規格に従い、ディスク・ドライブの信号を測定する場合は、J2 ディスク・ドライブ測定ソフト
ウェアを使用します。

タイミング性能を評価する場合は、JA3 Advanced または JE3 Essentials ジッタ解析ソフトウェアを使用し
ます。連続クロック・サイクルのジッタは、シングル・ショット・アクイジションにより解析してください。

CAN/LIN プロトコル・トリガおよび解析を実行する場合は、LSA シリアル解析ソフトウェアを使用します。

マスク適合性試験を実行するには、MTH コミュニケーション・マスク・テスト・ソフトウェアを使用します
（≥4 GHz モデルの場合）。

マスク適合性試験を実行するには、MTH コミュニケーション・マスク・テスト・ソフトウェアを使用します
（<4 GHz モデルの場合）。

マスク適合性試験を実行するには、MTU コミュニケーション・マスク・テスト・ソフトウェアを使用します
（≥4 GHz モデルの場合）。

シリアル適合性試験と解析を実行するには、RTE リアルタイム・アイ測定ソフトウェアを使用します。 多く
のシリアル・スタンダードに対応したコンプライアンス・モジュールです。

PCI-Express を実行するには、PCE RTE モジュールを使用します（≥4 GHz モデルの場合）。

高速シリアルまたはデータ・プロトコル上の 8 B/10 B データをトリガして、デコードする場合は、PTH シ
リアル・プロトコル・トリガ・ソフトウェアを使用します。オプション PTH 型では、最大 3.125 GS/s のプロト
コル・トリガが使用できます。デコードは、すべてのモデルで使用できます。

高速シリアルまたはデータ・プロトコル上の 8 B/10 B データをトリガして、デコードする場合は、PTM シ
リアル・プロトコル・トリガ・ソフトウェアを使用します。デコードは、すべてのモデルで使用できます。

高速シリアルまたはデータ・プロトコル上の 8 B/10 B データをトリガして、デコードする場合は、PTU シ
リアル・プロトコル・トリガ・ソフトウェアを使用します。オプション PTU では、最大 3.125 GS/s のプロトコ
ル・トリガが使用できます。デコードは、すべてのモデルで使用できます。

電源スイッチング・デバイスおよび磁気コンポーネントにおける電力損失をすばやく測定し、解析する場
合は、PWR 電力測定ソフトウェアを使用します。

オプション RTE 型では、SST Serial ATA および Serial Attached SCSI コンプライアンス・モジュール
を使用します。
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アプリケーション・ソフトウェアの実行

マスク・テストおよびパラメータ試験を含む USB2.0 信号を評価する場合は、USB を使用します（S/W の
み）。

CAN および LIN のテストを実行するには、VNM CAN/LIN プロトコル解析ソフトウェアを使用します
（CAN トリガは含まれません）。

ソフトウェアをインストールする場合は、
アプリケーション・ソフトウェアに付属の
手順書に従ってください。ソフトウェア
を実行するには、Analyze を選択して
から、アプリケーションを選択します。
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使用例

使用例

このセクションでは、一般的なトラブルシューティング作業で機器を使用する方法、および機器を拡張して
使用する方法について説明します。

間欠的に発生する異常の取り込み
設計エンジニアが直面する最も困難な作業の 1 つは、間欠的に発生するエラーの発見です。異常の種類
がわかっている場合は、オシロスコープの拡張トリガ機能を設定し、容易に異常を特定できます。しかし、対
象がわからない場合、特に、波形取り込みが低レートである従来のデジタル・ストレージ・オシロスコープを
使用している場合は、異常の特定は非常に単調で、時間を消費します。

DPX テクノロジにより実現したデジタル・フォスファ・オシロスコープは、FastAcq と呼ばれる非常に高速なア
クイジション・モードを備えており、そのモードを使用すると、従来の DPO で発見するのに何時間または何
日も要するような異常を数秒または数分で発見することができます。

間欠的に発生する異常を取り込むには、次の手順を使用します。
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1. プローブを入力信号ソースに接続
します。

<4 GHz モデル

≥4 GHz モデル

2. Autoset を押します。

3. Display > Display Persistence >
Infinite Persistence の順に選択しま
す。この例では、クロック信号を表
示しています。1、2 分信号を観察
したら、他の場所にある問題を検索
する前に、ステップ 4 に進みます。
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使用例

4. FastAcq を押します。

5. 信号内に存在するグリッチ、過渡的
現象、あるいは他の不規則な異常
を探します。 この例では、FastAcq
により、わずか数秒後に約 300 ns
の正のグリッチが発見されました。

DPO7000 シリーズおよび DPO70000 シリーズ・クイック・スタート・ユーザ・マニュアル 103



使用例

6. ステップ 5 で特定したグリッチで
トリガするには、Glitch Setup... を
選択します。

7. 適切な極性を選択します。

8. Level をクリックし、ステップ 5 で
発見された値を基にしてレベルを
設定します。

9. Width をクリックし、ステップ 5 で
発見された値を基にして幅を設定
します。

10.E-mail on Trigger をクリックして On
にします。 (110 ページ 「イベント
時の電子メールの設定」 参照)。

11.Single を押して、単一のグリッチで
トリガします。
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拡張デスクトップおよび OpenChoice アーキテクチャを使用した効率的
なドキュメント作成

多くの場合、エンジニアは後で参照できるように研究室の作業を文書化する必要があります。OpenChoice
アーキテクチャを使用すると、スクリーン・ショットおよび波形データを CD または USB メモリ・デバイスに保
存しておいて後でレポートを作成する代わりに、リアルタイムで作業を文書化することができます。

機器を中心として設計および文書化の処理を行うには、以下の手順を使用します。

1. Microsoft Word または Microsoft
Excel を機器に読み込みます。

2. モニタをもう 1 台接続します。
(7 ページ 「2 台めのモニタの追
加」 参照)。

3. Microsoft Word を開き、Word ウィ
ンドウを拡張デスクトップ上にドラッ
グします。

4. TekScope をクリックして、機器のア
プリケーションを再び表示します。
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5. Edit > Select for Copy > Full Screen
(bitmap) を選択します。

6. Ctrl+C を押します。

7. Word 文書内でスクリーン・ショッ
トを配置する場所をクリックして、
Ctrl+V を押します。

ヒント

機器には、さまざまな OpenChoice ソフトウェア・ツールが付属しています。これらのツールは、他の設計
環境の効率と接続性を最大限に高めるように設計されています。

バスでのトリガ
機器を使用して、CAN（オプション）、I2C、および SPI バスでトリガできます。 この機器では、物理層をア
ナログ波形として、CAN および LIN トリガについては、プロトコル・レベルの情報をデジタルおよび
シンボル波形として、その両方を表示できます。

注： 機器によっては使用できないトリガ・タイプもあります。
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使用例

バス・トリガをセットアップするには、次の手順を実行します。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

3. Trigger On を選択して、使用するト
リガ機能を選択します。

4. Trigger On の選択によっては、追
加の選択が必要な場合がありま
す。

ビデオ信号でのトリガ
機器は、 NTSC、SECAM、PAL、および HD 信号でのトリガをサポートしています。

ビデオ・フィールドでトリガするには、次の手順を実行します。

注： ビデオ・トリガを使用できない機器もあります。
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1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

Format > 525/NTSC を選択しま
す。

3. Trigger On > Field を選択します。

Odd、Even、あるいは All フィール
ドを選択します。
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ラインでのトリガ

フィールド内のビデオ・ラインを観察するには、次の手順を実行します。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

Format > 525/NTSC を選択しま
す。

3. Trigger On > All Lines を選択しま
す。
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イベント時の電子メールの設定

1. Utilities > E-mail on Event >
Setup... を選択します。

2. 受信者の電子メール・アドレス（1
つまたは複数）を入力します。エ
ントリが複数ある場合は、カンマで
区切ります。電子メール・アドレス・
ボックスに入力できる文字数は 252
文字までです。

3. Config をクリックして、SMTP Server
Address（SMTP サーバのアドレス）
を入力します。正確なアドレスにつ
いては、ネットワーク管理者に問い
合わせてください。
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4. 電子メール送信の必要なイベント
（1 つまたは複数）を選択します。

5. ファイルを添付する場合は、添付
ファイルの種類を選択し、Settings
をクリックして、フォーマットを指定
します。

6. メッセージ数の上限および電子
メールの最大サイズを設定します
（メッセージ数の上限は 50、電子
メールの最大サイズは 2000 MB で
す）。メッセージ数が上限に達した
場合は、Reset をクリックすると、イ
ベントで発生する電子メールを送
信できるようになります。

7. 電子メールのアドレスが正しく設定
されているか確認するには、Send
をクリックして、テスト・メールを送
信します。

8. 必要な場合は、Config をクリック
して、電子メール設定ダイアログ・
ボックスにアクセスして、設定を修
正します。

ヒント

機器のハード・ディスク・ドライブに添付ファイルを保存するには、最大メッセージ・サイズをゼロに設
定します。添付ファイルがデフォルトで保存される場所は、添付ファイルの種類に応じて異なります
（C:\TekScope\Screen、C:\TekScope\Waveforms、または C:\TekScope\Data のいずれか）。

有効な受信者の電子メール・アドレスまたは SMTP Server Address（SMTP サーバのアドレス）を入力
しないと、エラー・メッセージが表示されます。
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当社オシロスコープとロジック・アナライザ間でのデータ相関
設計の多くは、高速なクロック・エッジとデータ・レートを使用した高速設計です。これらの設計では、高速デ
ジタル信号のアナログ特性を回路内の複雑なデジタル・イベントと関連付けて観察する必要があります。
iView により、デジタルおよびアナログの世界への扉が開けます。iView の機能を使用すると、当社ロジッ
ク・アナライザとオシロスコープのデータをシームレスに統合し、自動的に時間相関を取ることができ、
マウスをクリックするだけで、アナログ波形をオシロスコープからロジック・アナライザの画面へ転送でき
ます。時間相関の取れたアナログ信号とデジタル信号を並べて表示し、捕捉が困難なグリッチなどの
問題の原因を瞬時に特定することができます。

iView 外部オシロスコープ・ケーブルを使用すると、ロジック・アナライザを当社オシロスコープに接続し、2
台の機器の間で通信を行うことができます。TLA アプリケーションの System（システム）メニューには、Add
External Oscilloscope（外部オシロスコープの追加）ウィザードが用意されています。このウィザードの手順
に従って、ロジック・アナライザとオシロスコープ間の iView ケーブルの接続を行うことができます。

また、オシロスコープ設定の確認、変更、およびテストに役立つセットアップ・ウィンドウも利用できます。波
形を取り込んで表示する前に、Add External Oscilloscope（外部オシロスコープの追加）ウィザードを使用し
て、当社ロジック・アナライザとオシロスコープ間の接続を確立する必要があります。

1. ロジック・アナライザの System メ
ニューから、Add iView External
Oscilloscope... を選択します。

2. 使用するオシロスコープのモデル
を選択します。

3. 画面上の手順に従って操作を行
い、Next をクリックします。

4. ロジック・アナライザとオシロスコー
プ間のデータ相関の詳細について
は、当社ロジック・アナライザのマ
ニュアルを参照してください。
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索引

English terms
Arm ステータス・ライト, 41
Autoset Undo（オートセットを元

に戻す）, 23
CAN, 107
Color Palette, 54
Cross Hair 目盛スタイル, 52
FastAｃｑ/WfmDB パレット, 54
FastFrame, 30, 32
Frame（フレーム）目盛スタイ

ル, 52
Full 目盛スタイル, 52
Grid 目盛スタイル, 52
H Bar カーソル, 69
I2C, 107
iView, 112
Label, 51
Math arbitrary filters, 75
Math editor, 73
Monochrome Gray カラー・パ

レット, 54
Monochrome Green カラー・パ

レット, 54
MultiView ズーム, 55
MyScope

使用, 86, 87
新しいコントロール・ウィン

ドウ, 82
Normal カラー・パレット, 54
Objects

表示, 53
OpenChoice

example, 105
Ready ステータス・ライト, 41
Screen カーソル, 69
Sin(x)/x 補間法, 50
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